
Network Printing Guide

Operating Instructions
Read this manual carefully before you use this product and keep it handy for future
reference.
For safety, please follow the instructions in this manual.



Introduction

To get maximum versatility from this machine all operators should carefully read and follow the instruc-
tions in this manual. Please keep this manual in a handy place near the machine.

Please read the Safety Information in the Copy Reference before using this machine. It contains im-
portant information related to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Important

Parts of this manual are subject to change without prior notice. In no event will the company be liable
for direct, indirect, special, incidental, or consequential damages as a result of handling or operating
the machine.

Software Version Conventions Used in this Manual

• NetWare 3.x means NetWare 3.12 and 3.2.

• NetWare 4.x means NetWare 4.1, 4.11 and IntranetWare.

Trademarks

Apple, AppleTalk, EtherTalk, LaserWriter, Macintosh and Mac are registered trademarks of Apple
Computer, Inc.

Ethernet is a registered trademark of Xerox Corporation.

Microsoft, Windows and Windows NT are registered trademarks of Microsoft Corporation in the United
States and/or other countries.

Netscape and Netscape Navigator are registered trademarks of Netscape Communications Corpora-
tion.

Novell, NetWare and NDS are registered trademarks of Novell, Inc.

PostScript is a registered trademark of Adobe Systems, Incorporated.

Sun is a registered trademark of Sun Microsystems, Inc.

SunOS is a trademark of Sun Microsystems, Inc.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

Note

The proper names of the Windows operating systems are as follows:

• Microsoft® Windows® 95 operating system

• Microsoft® Windows® 98 operating system

• Microsoft® Windows® Millennium Edition

• Microsoft® Windows® 2000 Professional

• Microsoft® Windows® 2000 Server

• Microsoft® Windows NT® Server operating system Version 4.0

• Microsoft® Windows NT® Workstation operating system Version 4.0



Manuals for This Machine

The following manuals describe the operational procedures and maintenance of
this machine.
To enhance safe and efficient operation of this machine, all users should read
and follow the instructions carefully.

❖❖❖❖ Copy Reference
Describes the procedures and functions for using this machine as a copier.

❖❖❖❖ System Settings
Describes the system settings of this machine.

❖❖❖❖ Printer Unit Type 1027 Printer Reference 1
Describes the system settings, procedures and functions for using this ma-
chine as a printer.

❖❖❖❖ Printer Unit Type 1027 Printer Reference 2
Describes the procedures and provides necessary information about using
this machine as a printer. This manual is included as a PDF file on the CD-
ROM labeled “Operating Instructions for Printer”.

❖❖❖❖ Network Printing Guide Operating Instructions
Describes the procedures and provides necessary information about setting
up and using the printer under the network environment. We recommend
this manual as your first choice to read, and it is included as a PDF file on the
CD-ROM labeled “Operating Instructions for Printer” (this manual).

❖❖❖❖ PostScript 3 Unit Type 1027 Operating Instructions Supplement
Describes the menus and features you can set using the PostScript 3 printer
driver. This manual is provided as a PDF file on the CD-ROM labeled “Oper-
ating Instructions for Printer”.

❖❖❖❖ UNIX Supplement
Provides information about setting up and using the printer in a UNIX envi-
ronment. Concerning UNIX printing information, please visit our web site or
consult your authorized reseller.
i



ii
How to Read This Manual

Symbols

In this manual, the following symbols are used:

R WARNING:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

R CAUTION:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury or damage to property.
* The statements above are notes for your safety.

Important
If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation
This symbol indicates the prior knowledge or preparations required before op-
erating.

Note
This symbol indicates precautions for operation, or actions to take after misop-
eration.

Limitation
This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference
This symbol indicates a reference.

[ ]
Keys that appear on the machine's panel display.
Keys and buttons that appear on the computer's display.

{ }
Keys built into the machine's control panel.
Keys on the computer's keyboard.



Introduction

This manual contains detailed instructions on configuring the machine as a net-
work printer. Read the section appropriate to your network environment on
how to configure the machine correctly.

Important
❒ The procedures written in this manual assume that you are a network admin-

istrator. If you are not, be sure to consult your network administrator before
configuration.

Reference
For more information about installing the Network Interface Board, see the
Printer Unit Type 1027 Printer Reference 1 that came with the printer option
or printer/scanner option of this machine.
For more information about connecting network cables, see the System Set-
tings manual.
For more information about configuring the Network Interface Board with
the control panel, see the System Settings that came with the printer option or
printer/scanner option of this machine.

NetWare (Server)

Windows NT (Server)
Windows 2000,

Windows 95/98/Me

Macintosh

         NetWare
          (Client)

Windows NT

Windows 2000

UNIX
iii



iv
❖❖❖❖ Features
• Support for 100BASE-TX and 10BASE-T
• The Network Interface Board is compatible with NetWare (IPX/SPX,

TCP/IP), Windows NT 4.0 (TCP/IP, NetBEUI, IPP *1 ), Windows 2000
(TCP/IP, NetBEUI, IPP *1 ), Windows 95/98/Me (TCP/IP, NetBEUI, IPP *1 ),
UNIX (TCP/IP) and Macintosh (AppleTalk) protocols. This allows you to
use the machine in a network that uses different protocols and operating
systems.

• A computer used as a dedicated print server is not required because the
Network Interface Board can be configured as a NetWare print server.

• The Network Interface Board can connect the machine to the network
without requiring its own power supply because the Network Interface
Board is installed inside the machine.

*1 IPP (Internet Printing Protocol) is a protocol for printing via the Internet.



Setting Up the Machine on a Network

Windows 95/98/Me

For setting up the machine as a network printer in a Windows 95/98/Me envi-
ronment, see p.1 “Windows 95/98/Me Configuration”. There are two methods
for using the machine as a network printer.

Windows 2000 or
Windows NT Server
(or Workstation) 
Print Server

Windows 95/98/Me

TCP/IP
NetBEUI
IPP

Windows 95/98/Me

❖Printing Without a Print Server ❖Printing With a Windows 2000 or
   Windows NT Print Server
v
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Windows 2000

For setting up the machine as a network printer in a Windows 2000 environ-
ment, see p.13 “Windows 2000 Configuration”. There are two methods for using
the machine as a network printer.

Windows NT 4.0

For setting up the machine as a network printer in a Windows NT 4.0 environ-
ment, see p.27 “Windows NT 4.0 Configuration”. There are two methods for us-
ing the machine as a network printer.

Windows 2000Windows 2000

Windows 2000 or
Windows NT Server
(or Workstation) 
Print Server

❖Printing Without a Print Server ❖Printing With a Windows 2000 or
   Windows NT Print Server

TCP/IP
NetBEUI
IPP
LPR

Windows NT 4.0Windows NT 4.0

TCP/IP
NetBEUI
IPP
LPR

Windows 2000 or
Windows NT Server
(or Workstation) 
Print Server

❖Printing Without a Print Server ❖Printing With a Windows 2000 or
   Windows NT Print Server



NetWare

For setting up the machine as a network printer in a NetWare environment, see
p.41 “NetWare Configuration”. The Network Interface Board allows you to use
the machine as either a print server or a remote printer.
For more information about setting up the clients, see the following pages.
• Windows 95/98/Me ⇒ p.60 “Windows 95/98/Me” 
• Windows 2000 ⇒ p.61 “Windows 2000” 
• Windows NT 4.0 ⇒ p.62 “Windows NT 4.0” 

Configuring the machine as a print server

A dedicated NetWare print server is not required because the machine can be
configured as a print server.

The actual procedures for configuring the machine depend on the NetWare ver-
sion.
• NetWare 3.x ⇒ p.47 “Setting Up as a Print Server” 
• NetWare 4.x, 5/5.1 ⇒ p.53 “Setting Up as a Print Server” 

NetWare
File Server

Print Server

Windows 95/98/Me Windows 2000 Windows NT 4.0
vii
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Configuring the machine as a remote printer

If a dedicated NetWare print server is being used, the machine should be config-
ured as a remote printer.

The actual procedures for configuring the machine depend on the NetWare ver-
sion.
• NetWare 3.x ⇒ p.49 “Setting Up as a Remote Printer” 
• NetWare 4.x, 5/5.1 ⇒ p.57 “Setting Up as a Remote Printer” 

Macintosh

For setting up the machine as a network printer in a Macintosh environment, see
p.63 “Macintosh Configuration”.

NetWare
Print Server

NetWare
File Server

Remote Printer

Windows 95/98/Me Windows 2000 Windows NT 4.0

AppleTalk

Macintosh



UNIX

Concerning UNIX printing informationl, please visit our web site or consult
your authorized reseller.

TCP/IP

UNIX
ix
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1. Windows 95/98/Me
Configuration
Configuring Windows 95/98/Me

Printing Without a Print Server

The following procedure describes how to configure Windows 95/98/Me to use
the machine on a network without a Windows 2000 Server, Windows 2000 Pro-
fessional, Windows NT Server, Windows NT Workstation, or NetWare based
print server.

Printing with a Windows 2000 or Windows NT Print Server

See p.11 “Setting up a Client Computer” for configuring Windows 95/98/Me
with a Windows 2000 or Windows NT print server.

Consult your network administrator about which of the three protocols is appropriate.

2.  Configure the chosen protocol

3.  Select the appropriate software

1.  Specify the protocol to use

         TCP/IP

4.  Install the software and set 
the printer driver port

"Using SmartNetMonitor
 for Client"

"Using SmartNetMonitor
 for Admin"

SmartNetMonitor
 for Admin

SmartNetMonitor
 for Client

"Configuring TCP/IP and IPP for Printing"
"Configuring NetBEUI
   for Printing"

If using the printer... I f  managing pr inters. . .

indicates topics explained in this document

IPP NetBEUI

4.  Install the software
1
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Configuring Protocols

Configuring TCP/IP and IPP for Printing

These instructions are for configuring the Network Interface Board and Win-
dows 95/98/Me to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
• Make sure that the TCP/IP protocol is set to active. (The default is active.)
• Assign an IP address and make other settings required for using the TCP/IP

protocol.

Reference
For more information about how to make the above settings, see the System
Settings.
If DHCP is used to assign IP addresses, see p.90 “When Using DHCP”.

Note
❒ After setting the IP address, use the ping command to make sure that it has

been set correctly.
A Enable the use of the command prompt as follows:

• On Windows 95 or Windows 98
Click [Start], point to [Programs], and then click [Command Prompt].

• On Windows Me
Click [Start], point to [Programs], point to [Accessories], and then click
[Command Prompt].

B Type the following: (Example IP address is 192.168.15.16)
C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.



Configuring Protocols
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Configuring a Windows 95/98/Me computer

These steps are for configuring a Windows 95/98/Me computer to use the
TCP/IP protocol.

AAAA Open [Control Panel] and double-click the [Network] icon. Make sure that
“TCP/IP” is listed in the [The following network components are installed:] box on
the [Configuration] tab.

Note
❒ If the TCP/IP protocol is not installed, click [Add] on the [Configuration] tab

to install it. For more information about installing the TCP/IP protocol, see
Windows 95/98/Me Help.

BBBB Configure the TCP/IP protocol with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.

Configuring NetBEUI for Printing

These instructions are for configuring the Network Interface Board and Win-
dows 95/98/Me to use the NetBEUI protocol.

Configuring the machine

Configure the machine to use the NetBEUI protocol.
• Make sure that the NetBEUI protocol is set to active. (The default is active.)

Reference
For more information about how to make the above settings, see the System
Settings.

Configuring a Windows 95/98/Me computer

Install the NetBEUI protocol on the Windows 95/98/Me computer and set it as
the default protocol.

AAAA Open [Control Panel] and double-click the [Network] icon. Make sure that
“NetBEUI” is listed in the [The following network components are installed:] box
on the [Configuration] tab.

Note
❒ If the NetBEUI protocol is not installed, click [Add] on the [Configuration] tab

to install it. For more information about installing the NetBEUI protocol,
see Windows 95/98/Me Help.

❒ If “NetBEUI →Dial-Up Adaptor” is listed in the [The following network com-
ponents are installed:] box, select it and click [Remove] to remove the binding.
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BBBB Set the NetBEUI protocol as the default protocol. Click the [Configuration]
tab, select “NetBEUI” in the [The following network components are installed:]
box, and click [Properties].

CCCC Click the [Advanced] tab, select [Set this protocol to be the default protocol], and
click [OK].

DDDD Click [OK] to close the [Network] dialog box.

EEEE When the message to restart appears, click [Yes].



Using SmartNetMonitor for Client
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Using SmartNetMonitor for Client 

SmartNetMonitor for Client is a utility that helps you to use network printers ef-
fectively. It is useful in environments where two or more network printers are
used. It is recommended that you install SmartNetMonitor for Client to use Par-
allel Printing and Recovery Printing. For more information about SmartNet-
Monitor for Client, see SmartNetMonitor for Client Help.

❖❖❖❖  SmartNetMonitor for Client features
• Sends a print job directly to the network printers without using a print

server.
• Notifies when a printing error occurs.
• Prints documents using other printers in the printer group when the spec-

ified printer is busy (Recovery Printing).
• Equally divides the number of copies to be printed among the selected

printers in the printer group (Parallel Printing).

Important
❒ The following must be the same for the specified printer and the print-

ers selected for Recovery Printing or Parallel Printing.
• Printer models (for Parallel Printing only)
• Installed options (e.g. Paper tray unit)
• Size and orientation of paper in each paper tray unit
• Total memory
• Installed fonts (including the downloaded fonts)

Note
❒ Failure to meet any of the conditions above may result in unexpected

print results.

Reference
For more information about installing SmartNetMonitor for Client, see the
Printer Unit Type 1027 Printer Reference 1.

Note
❒ Make sure to close all applications before beginning the installation process.

Installing SmartNetMonitor for Client may require the computer to be restart-
ed.
5
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Installing SmartNetMonitor for Client 

Follow the procedure below to install SmartNetMonitor for Client.

AAAA Configure the IP parameters on the Network Interface Board using the op-
eration panel.

Reference
For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in the System Settings.

BBBB Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

Note
❒ If the installer starts automatically, you can use it to install SmartNetMon-

itor for Client. Follow the instructions on the screen.

CCCC Open [Control Panel], and double-click the [Add/Remove Programs] icon.

DDDD On the [Install/Uninstall] tab, click [Install].

EEEE Click [Next >].

FFFF Type the name of the CD-ROM drive in the [Command line for installation program]
box, followed by “:\ NETWORK \ NETMON \ CLIENT \ DISK1 \ SETUP.EXE”
(do not include the quotation marks), and then click [Finish].

Note
❒ An example would be “D:\ NETWORK \ NETMON \ CLIENT \ DISK1 \ SETUP.EXE”

when the CD-ROM drive letter is “D”.

GGGG From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

HHHH After the [Welcome] dialog box appears, click [Next >].
Follow the instructions on the screen.
After the installation is complete, configure the printer port with SmartNet-
Monitor for Client. ⇒ p.8 “Setting Up the Printer Driver” 

Note
❒ If the dialog box asking if you want to restart the computer appears, select

[Yes, I want to restart my computer now.].



Using SmartNetMonitor for Client

1

Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, and then delete it. For more information about SmartNetMonitor for
Client, see SmartNetMonitor for Client Help.

AAAA From the [Printers] window, click the icon of the printer which uses Smart-
NetMonitor for Client to print. On the [File] menu, click [Properties].

BBBB Click the [Details] tab and make sure that the SmartNetMonitor for Client
port is shown in the [Print to the following port] box.
Remember the port name because this port should be deleted later.

CCCC From the [Print to the following port] box, select [FILE].

DDDD Click [Delete Port].

EEEE Click the SmartNetMonitor for Client port name as in step BBBB, and then click
[OK]. 

The port is deleted.

FFFF Click [OK] to close the printer properties.

Uninstalling SmartNetMonitor for Client 

Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:
• The SmartNetMonitor for Client settings dialog box is closed.
• No printer is using the SmartNetMonitor for Client port as a printer port.

AAAA Open [Control Panel], and double-click the [Add/Remove Programs] icon.

BBBB On the [Install/Uninstall] tab, click [SmartNetMonitor for Client], and click [Add/Re-
move].

CCCC After the confirmation message appears, click [Yes].
UninstallShield removes all of the components of SmartNetMonitor for Cli-
ent.

DDDD After the confirmation message, click [Yes].

EEEE Acknowledge the [Question] dialog box.

FFFF When the uninstallation is complete, click [OK].
7
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Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

Preparation
The target printer must be turned on before starting the installation process.

AAAA Install the printer driver of the printer you want to use.

BBBB From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

CCCC Click the [Details] tab and click [Add Port].

DDDD Click [Other], click [SmartNetMonitor] from the list, and then click [OK].

The [Select Printer] dialog box appears .
The displayed items are as follows:
Model Name: The model name of the printer. 
Name: The name of the Network Interface Board.
Comment: Additional information about the Network Interface Board.
Address: The IP address of the printer.

EEEE Select the printer.

TCP/IP

AAAA Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an IP broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address], and
then type the IP address or host name.

❒ You cannot add an address partially similar to that already used. For ex-
ample, when “192.168.0.2” is already used, “192.168.0.2xx” cannot be
used. Similarly, when “192.168.0.20” is already used, “192.168.0.2” can-
not be used. 
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NetBEUI

AAAA Click [NetBEUI].
A list of printers that can be printed to by the NetBEUI protocol appears.

BBBB Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to a broadcast from the computer will be displayed.

To print to a printer not listed here, click [Specify Address], and then type
the NetBEUI address. Make sure that the NetBEUI address is on the con-
figuration page. For more information about the printing of the configu-
ration page, see the Printer Unit Type 1027 Printer Reference 2.

❒ You cannot print to printers beyond routers.

IPP

AAAA Click [IPP].
The IPP setting dialog box appears.

BBBB To specify the IP address of the printer, type in "http://printer's-ip-ad-
dress/printer" or "ipp://printer's-ip-address/printer" in the [Printer URL]
field.
(Example IP address is 192.168.15.16)
http://192.168.15.16/printer

ipp://192.168.15.16/printer

CCCC As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name differing from those of any existing port names.
If you omit this, the address typed in [Printer URL] will be set as the IPP port
name.

DDDD If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

Note
❒ For more information about these settings, see SmartNetMonitor for

Client Help.

FFFF Click [OK].

GGGG Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port] box, and click [OK].
This completes the settings.
To print, select the specified printer. SmartNetMonitor for Client will now di-
rect print data to the printer automatically.
9
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Changing Port Settings

Follow these steps to change SmartNetMonitor for Client settings, such as Par-
allel Printing, Recovery Printing, TCP/IP, the proxy server and IPP URL.

Note
❒ There are no settings for the NetBEUI protocol.
❒ You can configure Timeout Settings for the TCP/IP protocol.

AAAA From the [Printers] window, click the printer icon. On the [File] menu, click
[Properties].

BBBB Click the [Details] tab, and then click [Port Settings].

The [Port Settings] dialog box appears.
• For IPP, you can configure User Settings, Proxy Settings and Timeout Set-

tings.

Note
❒ For more information about these settings, see SmartNetMonitor for Client

Help.



Setting up a Client Computer
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Setting up a Client Computer

This section describes the procedures for setting up a client on a network that
uses Windows 2000, Windows NT Server or Windows NT Workstation as a
print server.
When using a Windows 2000 or Windows NT print server, select a shared print-
er on Windows 2000 or Windows NT.

Note
❒ This section assumes that the client has already been configured to communi-

cate with a Windows 2000 or Windows NT print server. Do not begin the fol-
lowing procedure until the client has been set up and configured correctly.

AAAA Install the printer driver as a local printer.

Reference
For more information about installing the printer driver, see the Printer
Unit Type 1027 Printer Reference 1.

Note
❒ Any port can be selected during the installation, however, LPT1 is recom-

mended.

BBBB Click [Start], point to [Settings], and then click [Printers].

CCCC Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

DDDD Click the [Details] tab, and click [Add Port].

EEEE Click [Network], and click [Browse].

Windows 2000 or 
Windows NT Print Server

Windows 95/98/Me
11
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FFFF On the network tree, double-click the name of the computer used as the
print server.

The printers connected to the network are displayed.

GGGG Click the name of the printer you want to use, and click [OK].

HHHH Click [OK].

IIII Make sure that the port name is displayed in the [Print to the following port]
box, and click [OK].



2. Windows 2000
Configuration
Configuring Windows 2000

Printing Without a Print Server

The following procedure describes how to configure Windows 2000 to use the
machine on a network without a Windows 2000, Windows NT Server, Windows
NT Workstation or NetWare based print server.

Consult your network administrator about which of the three protocols is appropriate.

2.  Configure the chosen protocol

3.  Select the appropriate software

1.  Specify the protocol to use

         TCP/IP

4.  Install the software and set 
the printer driver port

"Using SmartNetMonitor
 for Client"

"Using SmartNetMonitor
 for Admin"

SmartNetMonitor
 for Admin

SmartNetMonitor
 for Client

"Configuring TCP/IP and IPP for Printing"
"Configuring NetBEUI
   for Printing"

If using the printer... I f  managing pr inters. . .

indicates topics explained in this document

IPP NetBEUI

4.  Install the software
13
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Printing with a Standard TCP/IP Port

Standard TCP/IP port is a standard port of Windows 2000 to enable Peer-to-
Peer printing in a network environment.
For more information about Standard TCP/IP port settings, see Windows 2000
Help.

Note
❒ If a device model selection dialog box appears during the procedure to add

the standard TCP/IP port, select "RICOH Network Printer C Model".

Printing with a LPR Port

See p.23 “Configuring LPR Port Printing” for configuring a LPR port in Win-
dows 2000.

Printing with a Windows 2000 or Windows NT Print Server

See p.24 “Setting up a Client Computer” for configuring Windows 2000 with a
Windows 2000 or Windows NT print server.
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Configuring the Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows 2000 to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
• Make sure that the TCP/IP protocol is set to active. (The default is active.)
• Assign an IP address and make other settings required for using the TCP/IP

protocol.

Reference
For more information about how to make the above settings, see the System
Settings.
If DHCP is used to assign IP addresses, see p.90 “When Using DHCP”.

Note
❒ After setting the IP address, use the ping command to make sure that it has

been set correctly.
A Click [Start], point to [Programs], point to [Accessories], and then click [Com-

mand Prompt].
B Type the following: (Example IP address is 192.168.15.16)

C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.

Configuring a Windows 2000 computer

Follow these steps to configure a Windows 2000 computer to use the TCP/IP
protocol.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

BBBB Click [Local Area Connection]. On the [General] tab, click [Properties].
15
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CCCC Make sure that the“Internet Protocol (TCP/IP)” is selected in the [Compo-
nents checked are used by this connection:] box on the [General] tab.

Note
❒ Select the TCP/IP protocol box if it is not already selected.
❒ If the TCP/IP protocol is not installed, click [Install] on the [General] tab to

install it. For more information about installing the TCP/IP protocol, see
Windows 2000 Help.

DDDD Configure the TCP/IP protocol with the appropriate IP address, subnet
mask and other settings.
Check with the network administrator that the settings are correct.

Configuring NetBEUI for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows 2000 to use the NetBEUI protocol.

Configuring the machine

Configure the machine to use the NetBEUI protocol.
• Make sure that the NetBEUI protocol is set to active. (The default is active.)

Reference
For more information about how to make the above settings, see the System
Settings.

Configuring a Windows 2000 computer

Follow these steps to configure a Windows 2000 computer to use the NetBEUI
protocol.

AAAA Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

BBBB Click [Local Area Connection]. On the [General] tab, click [Properties].

CCCC Make sure that the“NetBEUI Protocol” is selected in the [Components
checked are used by this connection:] box on the [General] tab.

Note
❒ Select the NetBEUI protocol box if it is not already selected.
❒ If the NetBEUI protocol is not installed, click [Install] on the [General] tab

and install it. For more information about installing the NetBEUI protocol,
see Windows 2000 Help.
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Using SmartNetMonitor for Client 

SmartNetMonitor for Client is a utility that helps you to use network printers ef-
fectively. It is useful in environments where two or more network printers are
used. It is recommended that you install SmartNetMonitor for Client to use Par-
allel Printing and Recovery Printing. For more information about SmartNet-
Monitor for Client, see SmartNetMonitor for Client Help.

❖❖❖❖  SmartNetMonitor for Client features
• Sends a print job directly to the network printers without using a print

server.
• Notifies when a printing error occurs.
• Prints documents using other printers in the printer group when the spec-

ified printer is busy (Recovery Printing).
• Equally divides the number of copies to be printed among the selected

printers in the printer group (Parallel Printing).

Important
❒ The following must be the same for the specified printer and the print-

ers selected for Recovery Printing or Parallel Printing.
• Printer models (for Parallel Printing only)
• Installed options (e.g. Paper tray unit)
• Size and orientation of paper in each paper tray unit
• Total memory
• Installed fonts (including the downloaded fonts)

Note
❒ Failure to meet any of the conditions above may result in unexpected

print results.

Reference
For more information about installing SmartNetMonitor for Client, see the
Printer Unit Type 1027 Printer Reference 1.

Note
❒ Make sure to close all applications before beginning the installation process.

Installing SmartNetMonitor for Client may require the computer to be restart-
ed.
17
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Installing SmartNetMonitor for Client 

Follow the procedure below to install SmartNetMonitor for Client.

AAAA Configure the IP parameters on the Network Interface Board using the op-
eration panel.

Reference
For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in the System Settings.

BBBB Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

Note
❒ If the installer starts automatically, you can use it to install SmartNetMon-

itor for Client. Follow the instructions on the screen.

CCCC Open [Control Panel], and double-click the [Add/Remove Programs] icon.

DDDD Click [Add New Programs], and then click [CD or Floppy].

EEEE Click [Next >].

FFFF Type the name of the CD-ROM drive in the [Open] box, followed by 
“:\ NETWORK \ NETMON \ CLIENT \ DISK1 \ SETUP.EXE” (do not include
the quotation marks), and then click [Finish].

Note
❒ An example would be “D:\ NETWORK \ NETMON \ CLIENT \ DISK1 \ SETUP.EXE”

when the CD-ROM drive letter is “D”.

GGGG From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

HHHH After the [Welcome] dialog box appears, click [Next >].
Follow the instructions on the screen.
After the installation is complete, configure the printer port with SmartNet-
Monitor for Client. ⇒ p.20 “Setting Up the Printer Driver” 

Note
❒ If the dialog box asking if you want to restart the computer appears, select

[Yes, I want to restart my computer now.].
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Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, then delete it. For more information about SmartNetMonitor for Cli-
ent, see SmartNetMonitor for Client Help.

AAAA From the [Printers] window, click the icon of the printer which uses Smart-
NetMonitor for Client to print. On the [File] menu, click [Properties].

BBBB Click the [Ports] tab and make sure that the SmartNetMonitor for Client
port is shown in the [Print to the following port(s)] box.
Remember the port name because this port should be deleted later.

CCCC Select the [FILE] check box in the [Port] column.

DDDD Click [OK] to close the Printer Properties.

The port which is currently in use is changed.

EEEE Open the Printer Properties of the same printer.

FFFF Select the [Ports] tab.

GGGG At the [Port] column in the [Print to the following port(s)] dialog box, click to se-
lect the SmartNetMonitor for Client port name as in step BBBB. 

HHHH Click [Delete Port].

IIII When the confirmation message appears, click [Yes].

The port is deleted.

JJJJ Click [Close] to close the Printer Properties.

Uninstalling SmartNetMonitor for Client 

Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:
• The port settings dialog box is closed.
• No printer is using the SmartNetMonitor for Client port as a printer port.
• You have performed login with the same user authority as that used to in-

stall SmartNetMonitor for Client.

AAAA Open [Control Panel], and double-click the [Add/Remove Programs] icon.

BBBB Click the [Change or Remove Programs] tab, click [SmartNetMonitor for Client],
and click [Change/Remove].
19
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CCCC After the confirmation message appears, click [Yes].

UninstallShield removes all of the components of SmartNetMonitor for Cli-
ent.

DDDD After the confirmation message appears, click [Yes].

EEEE Acknowledge the [Remove Shared File?] dialog box.

FFFF When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

Preparation
The target printer must be turned on before starting the installation process.

AAAA Install the printer driver for the printer you want to use.

BBBB From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

CCCC Click the [Ports] tab and click [Add Port].

DDDD Click [SmartNetMonitor for Client] in the [Available port types:] box, and then
click [New Port].

The [Select Printer] dialog box appears and printers on the network are
browsed. 
The displayed items are as follows: 
Model Name: The model name of the printer.
Name: The name of Network Interface Board.
Comment: Additional information about Network Interface Board.
Address: The IP address of the printer.

EEEE Select the printer.

TCP/IP

AAAA Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an IP broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address] and
then type the IP address or host name.
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NetBEUI

AAAA Click [NetBEUI].
A list of printers that can be printed by the NetBEUI protocol appears.

BBBB Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to a broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address] and
then type the NetBEUI address. Make sure that the NetBEUI address is
on the configuration page. For information about the printing of the
configuration page, see the Printer Unit Type 1027 Printer Reference 1.

❒ You cannot print to printers beyond routers.

IPP

AAAA Click [IPP].
The IPP setting dialog box appears.

BBBB To specify the IP address of the printer, type in "http://printer's-ip-ad-
dress/printer" or "ipp://printer's-ip-address/printer" in the [Printer URL]
field.
(Example IP address is 192.168.15.16)
http://192.168.15.16/printer

ipp://192.168.15.16/printer

CCCC As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name different from those of any existing port names.
If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.

DDDD If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

Note
❒ For more information about these setting, see SmartNetMonitor for Cli-

ent Help.

FFFF Click [OK].

GGGG Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port(s)] box, and click [Close].
This completes the settings.
To print, select the specified printer. SmartNetMonitor for Client will now di-
rect print data to the printer automatically.
21
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Changing Port Settings

Follow the steps to change SmartNetMonitor for Client settings, such as Parallel
Printing, Recovery Printing, TCP/IP, the proxy server and IPP URL.

Note
❒ There are no settings for the NetBEUI protocol.

AAAA From the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

BBBB Click the [Ports] tab, and then click [Configure Port].
The [Port Settings] dialog box appears
• For TCP/IP protocol, you can configure Parallel Printing, Recovery Print-

ing and Timeout Settings.
• For IPP, you can configure User Settings, Proxy Settings and Timeout Set-

tings.

Note
❒ For more information about these settings, see SmartNetMonitor for Client

Help.
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Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
2000.

Note
❒ The TCP/IP protocols must be installed and configured correctly. For more

information about configuring the protocols, see p.15 “Configuring TCP/IP
and IPP for Printing”.

AAAA Click [Start], point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

CCCC Click the [Ports] tab and click [Add Port].

DDDD In the [Available port types:] box, click “LPR Port”, and then click [New Port].

Note
❒ If “LPR Port” does not appear, “Print Services for Unix” has not been in-

stalled.

EEEE Type the IP address of the Network Interface Board into the [Name or address
of server providing lpd:] box.

FFFF Type “lp” into the [Name of printer or print queue on that server box:], and click
[OK].

GGGG Click [Close].

HHHH Make sure that the port name is displayed in the [Print to the following port(s)]
box and that the check box is selected, and then click [OK].
23
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Setting up a Client Computer

This section describes the procedures for setting up a client in a network that
uses Windows 2000, Windows NT Server or Windows NT Workstation as a
print server.
When using a Windows 2000 or Windows NT print server, select a shared print-
er on Windows 2000 or Windows NT.

Note
❒ This section assumes that the client has already been configured to communi-

cate with a Windows 2000 or Windows NT print server. Do not begin the fol-
lowing procedure until the client has been set up and configured correctly.

Use the [Printers] window to set up the printer.

AAAA Click [Start], point to [Settings] and then click [Printers].

BBBB Double-click the [Add Printer] icon.

This launches the Add Printer Wizard.

CCCC Click [Next >].

DDDD Click [Network printer], and click [Next >].

EEEE Click [Next >].

FFFF In the [Shared printers:] box, double-click the name of the computer used as
a print server.
The printers attached to the network are displayed.

Windows 2000

Windows 2000 or 
Windows NT Print Server
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GGGG Click the printer you want to use, and click [Next >].

Note
❒ If the printer driver is not installed in the print server, a message appears.

If a driver has been installed on the client, click [OK], and follow the in-
structions on the screen.

❒ There is a Windows 2000 printer driver on the CD-ROM labeled “Printer
Drivers and Utilities”.

HHHH Select whether to use this printer as the default printer, and click [Next >].

IIII After the installation is complete, click [Finish].

The icon of the newly installed printer appears in the [Printers] window.
25
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3. Windows NT 4.0
Configuration
Configuring Windows NT 4.0

Printing Without a Print Server

The following procedure describes how to configure Windows NT 4.0 to use the
machine on a network without a Windows 2000, Windows NT Server, Windows
NT Workstation or NetWare based print server.

Consult your network administrator about which of the three protocols is appropriate.

2.  Configure the chosen protocol

3.  Select the appropriate software

1.  Specify the protocol to use

         TCP/IP

4.  Install the software and set 
the printer driver port

"Using SmartNetMonitor
 for Client"

"Using SmartNetMonitor
 for Admin"

SmartNetMonitor
 for Admin

SmartNetMonitor
 for Client

"Configuring TCP/IP and IPP for Printing"
"Configuring NetBEUI
   for Printing"

If using the printer... I f  managing pr inters. . .

indicates topics explained in this document

IPP NetBEUI

4.  Install the software
27
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Printing with a LPR Port

See p.38 “Configuring LPR Port Printing” for how to configure a LPR port in
Windows NT 4.0.

Printing with a Windows 2000 or Windows NT Print Server

See p.39 “Setting up a Client Computer” for configuring Windows NT 4.0 with
a Windows 2000 or Windows NT print server.
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Configuring the Protocols

Configuring TCP/IP and IPP for Printing

These instructions are for configuring the Network Interface Board and Win-
dows NT to use the TCP/IP protocol and IPP.

Configuring the machine

Configure the machine to use the TCP/IP protocol.
• Make sure that the TCP/IP protocol is set to active. (The default is active.)
• Assign an IP address and make other settings required for using the TCP/IP

protocol.

Reference
For more information about how to make the above settings, see the System
Settings.
If DHCP is used to assign IP addresses, see p.90 “When Using DHCP”.

Note
❒ After setting the IP address, use the ping command to make sure that it has

been correctly set.
A Click [Start], point to [Programs], and then click [Command Prompt].
B Type the following: (Example IP address is 192.168.15.16)

C:\> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.

Configuring a Windows NT computer

These steps are for configuring a Windows NT computer to use the TCP/IP pro-
tocol.

AAAA Open [Control Panel] and double-click the [Network] icon. Make sure that
“TCP/IP Protocol” is listed in the [Network protocols] box on the [Protocols]
tab.

Note
❒ If the TCP/IP protocol is not installed, click [Add] on the [Protocols] tab to

install it. For more information about installing the TCP/IP protocol, see
Windows NT Help.
29
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BBBB Configure the TCP/IP protocols with the appropriate IP address, subnet
mask and other settings.

Check with the network administrator that the settings are correct.

CCCC Click the [Services] tab, and make sure that “Microsoft TCP/IP Printing” is
installed.

If “Microsoft TCP/IP Printing” is not installed, click [Add] on the [Services ]
tab, to install it. For more information about installing and configuring net-
work services, see Windows NT Help.

Configuring NetBEUI for Printing

These instructions are for configuring the Network Interface Board and Win-
dows NT to use the NetBEUI protocol.

Configuring the machine

Configure the machine to use the NetBEUI protocol.
• Make sure that the NetBEUI protocol is set to active. (The default is active.)

Reference
For more information about how to make the above settings, see the System
Settings.

Configuring a Windows NT computer

Install the NetBEUI protocol on the Windows NT computer, and change the
LAN adapter number (Lana Number).

AAAA Open [Control Panel] and double-click the [Network] icon. Make sure that
“NetBEUI Protocol” is listed in the [Network Protocols] box on the [Protocols]
tab.

Note
❒ If the NetBEUI protocol is not installed, click [Add] on the [Protocols] tab to

install it. For more information about installing the NetBEUI protocol, see
Windows NT Help.

BBBB Change the Lana Number. Click the [Services] tab, click “NetBIOS Inter-
face” in the [Services] tab, and click [Properties].

CCCC Click the Lana Number corresponding the Nbf protocol of the [Network
Route] headline, and click [Edit].
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DDDD Type “0” as the Lana Number.

Note
❒ If the other protocol's Lana Number is configured with “0”, you must

change the Lana Number a number other than “0”.

EEEE Click [OK].

FFFF Click [Close], and close the [Network] dialog box.

GGGG After acknowledging the message to restart, click [Yes].

Note
❒ After you change the Lana Number, you must restart the computer.
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Using SmartNetMonitor for Client 

SmartNetMonitor for Client is a utility that helps you to use network printers ef-
fectively. It is useful in environments where two or more network printers are
used. It is recommended that you install SmartNetMonitor for Client to use Par-
allel Printing and Recovery Printing. For more information about SmartNet-
Monitor for Client, see SmartNetMonitor for Client Help.

❖❖❖❖  SmartNetMonitor for Client features
• Sends a print job directly to the network printers without using a print

server.
• Notifies when a printing error occurs.
• Prints documents using other printers in the printer group when the spec-

ified printer is busy (Recovery Printing).
• Equally divides the number of copies to be printed among the selected

printers in the printer group (Parallel Printing).

Important
❒ The following must be the same for the specified printer and the print-

ers selected for Recovery Printing or Parallel Printing.
• Printer models (for Parallel Printing only)
• Installed options (e.g. Paper tray unit)
• Size and orientation of paper in each paper tray unit
• Total memory
• Installed fonts (including the downloaded fonts)

Note
❒ Failure to meet any of the conditions above may result in unexpected

print results.

Reference
For more information about installing the SmartNetMonitor for Client, see
the Printer Unit Type 1027 Printer Reference 1.

Limitation
❒ On a computer that is used as a print server, do not use the features such as

Parallel Printing, Recovery Printing and Notify. For more information about
turning off these features, see SmartNetMonitor for Client Help.

Note
❒ Make sure to close all applications before beginning the installation process.

Installing SmartNetMonitor for Client may require the computer to be restart-
ed.
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Installing SmartNetMonitor for Client 

Follow the procedure below to install SmartNetMonitor for Client.

AAAA Configure the IP parameters on the Network Interface Board using the op-
eration panel.

Reference
For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in the System Settings.

BBBB Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

Note
❒ If the installer starts automatically, you can use it to install SmartNetMon-

itor for Client. Follow the instructions on the screen.

CCCC Open [Control Panel], and double-click the [Add/Remove Programs] icon.

DDDD On the [Install/Uninstall] tab, click [Install].

EEEE Click [Next >].

FFFF Type the name of the CD-ROM drive in the [Command line for installation program]
box, followed by “:\ NETWORK \ NETMON \ CLIENT \ DISK1 \ SETUP.EXE”
(do not include the quotation marks), and then click [Finish].

Note
❒ An example would be “D:\ NETWORK \ NETMON \ CLIENT \ DISK1 \ SETUP.EXE”

when the CD-ROM drive letter is “D”.

GGGG From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

HHHH After the [Welcome] dialog box appears, click [Next >].
Follow the instructions on the screen.
After the installation is complete, configure the printer port with SmartNet-
Monitor for Client. ⇒ p.35 “Setting Up the Printer Driver” 

Note
❒ If the dialog box asking if you want to restart the computer appears, select

[Yes, I want to restart my computer now.].
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Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as “FILE”, then delete it. For more information about SmartNetMonitor for Cli-
ent, see SmartNetMonitor for Client Help.

AAAA From the [Printers] window, click the icon of the printer which uses Smart-
NetMonitor for Client to print. On the [File] menu, click [Properties].

BBBB Click the [Ports] tab and make sure that the SmartNetMonitor for Client
port is shown in the [Print to the following port] box.
Remember the port name because this port should be deleted later.

CCCC From the [Print to the following port] box, select [FILE].

DDDD Click [Apply].

The port which is currently in use is changed.

EEEE Click [Delete Port].

FFFF After the confirmation message appears, click [Yes].

The port is deleted.

GGGG Click [OK] to close the printer properties.

Uninstalling SmartNetMonitor for Client 

Preparation
Before uninstalling SmartNetMonitor for Client, make sure that:
• The port settings dialog box is closed.
• No printer is using the SmartNetMonitor for Client port as a printer port.
• You have performed login with the same user authority as that used to in-

stall SmartNetMonitor for Client.

AAAA Open [Control Panel], and double-click the [Add/Remove Programs] icon.

BBBB On the [Install/Uninstall] tab, click [SmartNetMonitor for Client] and click [Add/Re-
move].

CCCC After the confirmation message appears, click [Yes].
UninstallShield removes all of the components of SmartNetMonitor for Cli-
ent.

DDDD After a confirmation message appears, click [Yes].

EEEE Acknowledge the [Remove Shared File?] dialog box.

FFFF When the uninstallation is complete, click [OK].
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Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Smart-
NetMonitor for Client.

Preparation
The target printer must be turned on before starting the installation process.

AAAA Install the printer driver of the printer you want to use.

BBBB From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

CCCC Click the [Ports] tab and click [Add Port].

DDDD Click [SmartNetMonitor] from the list, and then click [New Port...].

The [Select Printer] dialog box appears .
The displayed items are as follows:
Model Name: The model name of the printer. 
Name: The name of the Network Interface Board.
Comment: Additional information about the Network Interface Board.
Address: The IP address of the printer.

EEEE Select the printer.

TCP/IP

AAAA Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to an IP broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address], and
then type the IP address or host name.

NetBEUI

AAAA Click [NetBEUI].

A list of printers that can be printed by the NetBEUI protocol appears.
BBBB Click the printer you want to use, and then click [OK].

Note
❒ Printers that respond to a broadcast from the computer will be dis-

played. To print to a printer not listed here, click [Specify Address] and
then type the NetBEUI address. Make sure that the NetBEUI address is
on the configuration page. For information about the printing of the
configuration page, see the Printer Unit Type 1027 Printer Reference 2.

❒ You cannot print to printers beyond routers.
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IPP

AAAA Click [IPP].
The IPP setting dialog box appears.

BBBB To specify the IP address of the printer, type in "http://printer's-ip-ad-
dress/printer" or "ipp://printer's-ip-address/printer" in the [Printer URL]
field.
(Example IP address is 192.168.15.16)
http://192.168.15.16/printer

ipp://192.168.15.16/printer

CCCC As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name different from those of any existing port names.
If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.

DDDD If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

Note
❒ For more information about these setting, see SmartNetMonitor for Cli-

ent Help.

FFFF Click [OK].

GGGG Make sure that the specified printing port is displayed in the [Print to the fol-
lowing Port] box, and then click [OK].

This completes the settings.
To print, select the printer specified here. SmartNetMonitor for Client will
now direct print data to the printer automatically.
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Changing Port Settings

Follow the steps to change SmartNetMonitor for Client settings, such as Parallel
Printing, Recovery Printing, TCP/IP, the proxy server settings and IPP URL.

Note
❒ There are no settings for the NetBEUI protocol.

AAAA From the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

BBBB Click the [Ports] tab, and then click [Port Configuration].
The [Port Settings] dialog box appears
• For TCP/IP protocol, you can configure Recovery Printing, Parallel Print-

ing and Timeout Settings.
• For IPP, you can configure User Settings, Proxy Settings and Timeout Set-

tings.

Note
❒ For more information about these settings, see SmartNetMonitor for Client

Help.
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Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
NT.

Note
❒ The following procedure assumes that the printer drivers have already been

installed. This is the procedure to change the printer port to LPR.
❒ The TCP/IP protocols must be installed and configured correctly. For more

information about configuring the protocol, see p.29 “Configuring TCP/IP
and IPP for Printing”.

AAAA Click [Start], point to [Settings], and then click [Printers].

BBBB Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

CCCC Click the [Ports] tab, and then click [Add Port].

DDDD In the [Available Printer Ports] box, click “LPR Port”, and then click [New Port].

Note
❒ If “LPR Port” does not appear, “Microsoft TCP/IP Printing” has not been

installed.

EEEE Type the IP address of the Network Interface Board into the [Name or address
of server providing lpd] box.

FFFF Type “lp” into the [Name of printer or print queue on that server] box, and click
[OK].

GGGG Click [Close].

HHHH Make sure that the port name is displayed in the [Print to the following port(s)]
box and the check box is selected, and then click [OK].
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Setting up a Client Computer

This section describes the procedures for setting up a client in a network that
uses Windows 2000, Windows NT Server or Windows NT Workstation as a
print server.
When using a Windows 2000 or Windows NT print server, select a shared print-
er on Windows 2000 or Windows NT.

Note
❒ This section assumes that the client has already been configured to communi-

cate with a Windows 2000 or Windows NT print server. Do not begin the fol-
lowing procedure until the client has been set up and configured correctly.

Use the [Printers] window to set up the printer.

AAAA Click [Start], point to [Settings], and then click [Printers].

BBBB Double-click the [Add Printer] icon.

This launches the Add Printer Wizard.

CCCC Click [Network printer server] and click [Next >].

DDDD In the [Shared Printers] box, double-click the name of the computer used as a
print server.

The printers attached to the network are displayed.

EEEE Click the printer you want to use and click [OK].

Note
❒ If the printer driver is not installed in the print server, a message appears.

If a driver has been installed on the client, click [OK] and follow the instruc-
tions on the screen.

❒ There is a Windows NT printer driver on the CD-ROM labeled “Printer
Drivers and Utilities”.

Windows NT 4.0

Windows 2000 or 
Windows NT Print Server
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FFFF Select if you want to use this printer as the default printer, and click [Next >].

GGGG After the installation is complete, click [Finish].
The icon of the newly installed printer appears in the [Printers] window.



4. NetWare Configuration
This chapter describes how to configure the machine to use as a print server or
a remote printer in a NetWare environment.

Note
❒ NetWare must be set to active using the machine's control panel. For more in-

formation about how to set it, see the System Settings.

Installing the NIB Setup Tool 

A utility called the NIB Setup Tool is provided to configure the machine to work
in a network environment. This section describes how to install the SmartNet-
Monitor for Admin, and how to run the NIB Setup Tool.

Limitation
❒ The NIB Setup Tool is supported to work with the following operating sys-

tems.
• Microsoft Windows 95/98/Me
• Microsoft Windows 2000
• Microsoft Windows NT 4.0

Installing SmartNetMonitor for Admin 

Follow these steps to install the SmartNetMonitor for Admin.

Preparation
You should install the SmartNetMonitor for Admin on the computer. If you
install the SmartNetMonitor for Admin from a file server or run it via the net-
work, the SmartNetMonitor for Admin might not work correctly.
Make sure to close all applications before starting the installation procedure.

AAAA Close all the applications that are currently running.

BBBB Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.
If the installer starts automatically, follow the instructions on the screen.
If not, go to step C.

CCCC Open [Control Panel], and double-click the [Add/Remove Programs] icon.

DDDD On the [Install/Uninstall] tab, click [Install].

EEEE Click [Next >].
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FFFF In the [Command line for installation program] box, type the name of the CD-ROM
drive followed by “:\ NETWORK\NETMON\ADMIN\DISK1\SETUP.EXE”
(do not include the quotation marks), and then click [Finish].

Note
❒ An example would be “D:\ NETWORK\NETMON\ADMIN\DISK1\SETUP.EXE”

when the CD-ROM drive name is “D”.

GGGG From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

HHHH After the [Welcome] dialog box appears, click [Next >].

IIII The [Software License Agreement] dialog box appears. 

After reading through all of the contents by clicking [TTTT], click [Yes] to agree
with the License Agreement.

JJJJ Select a folder to install the SmartNetMonitor for Admin in, and then click
[Next >].

If you want to change the displayed folder, click [Browse] to select another
one.
The installation program starts.
When the confirmation dialog box appears, the installation program is com-
plete.

Running the NIB Setup Tool 

AAAA Click [Start], point to [Programs], and then click [NIB Setup Tool] in the [Smart-
NetMonitor for Admin] program folder.
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Quick Setup Using the NIB Setup Tool 
Wizard

With the NIB Setup Tool, you can easily set up a NetWare printing environment. 

Reference
For more information about installing the NIB Setup Tool, see p.41 “Installing
the NIB Setup Tool”.

You can select [Wizard] or [Property Sheet] as an installation method.
When you configure the Network Interface Board for the first time, use the Wiz-
ard method.
If you want to use the Property Sheet method, see p.46 “NetWare 3.x - Advanced
Settings” or p.52 “NetWare 4.x, 5/5.1 - Advanced Settings”.

Note
❒ This section assumes that NetWare is functional and that the necessary envi-

ronment for NetWare Print Services is available.
❒ If you configure the Network Interface Board in a NetWare environment us-

ing the NIB Setup Tool, you should install the client software released from
Novell in the following cases.
• Windows 95/98/Me in NDS mode configuration
• Windows NT 4.0 in NDS mode configuration
• Windows NT 4.0 in Bindery mode configuration
• Windows 2000 in NDS mode configuration
• Windows 2000 in Bindery mode configuration

AAAA Log on to the Netware file server or the NDS tree as an Admin or Admin
equivalent.

BBBB Run the NIB Setup Tool.

Reference
 ⇒ p.42 “Running the NIB Setup Tool” 

CCCC Click [Wizard] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

DDDD Click [IPX protocol].
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EEEE Click to select the IPX address of the Network Interface Board you are con-
figuring, and click [Next >].

Note
❒ If you do not know which Network Interface Board you are configuring,

print a network configuration page to check the MAC address (Network
address).

FFFF Make sure that the MAC address and IPX address are correct, and click [Fin-
ish].

GGGG Type the print server name into the [Device Name] box, and click [Next >].
The default setting is “RDP_” followed by the 6 digit serial number. We rec-
ommend that you change it to something that is easier to remember or some-
thing based on the structure of the network.

HHHH In a dialog box for selecting a network environment, click to select the [Net-
Ware] check box and click to clear the [TCP/IP] check box.

IIII Click [Next >].
A dialog box for configuring the NetWare environment appears.

JJJJ Select [Bindery] when printing under Bindery mode, or select [NDS] when
printing under NDS mode.

When you are using NetWare version 4.x, you should select [NDS].

KKKK If you selected [Bindery], type into the [File Server Name:] box the name of the
file server in which a print server is to be created.

After clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

LLLL If you selected [NDS], type into the [Tree:] box the name of the NDS tree in
which the print server is created, and type the context into the [Context:] box.

Clicking [Browse], you can select an NDS tree and an NDS context among
those listed in the [Browse] dialog boxes.
As a context, object names are typed from a lower object and divided by a pe-
riod. For example, if you want to create a print server into NET under DS,
type “NET.DS”.

MMMM Click [Next >].
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NNNN Type the name of the printer into the [Printer Name] box, and the name of the
print queue into the [Print Queue Name] box.

The default setting for Printer Name is “Print Server Name” followed by “_1”
and for Print Queue Name is “Print Server Name” followed by “_Q” (quota-
tion marks are not included). You can change them if necessary.

OOOO If you have selected the NDS mode, type the volume of the print queue into
the [Queue Volume] box. 
Clicking [Browse], you can select one of those shown in the [Browse] dialog
box.

PPPP Click [Next >].

A dialog box to acknowledge the printing environment appears.

QQQQ After acknowledging the environment, click [Next >].
If you want to change the settings, click [< Back] and make the settings again.
Clicking [Next >], the NIB Setup Tool automatically creates the Print Server,
the Printer, and the Print Queue in the NetWare network.

RRRR After the confirmation dialog box appears, select [Quit] and click [Finish] to
exit the NIB Setup Tool.
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NetWare 3.x - Advanced Settings

The actual procedures for configuring the machine vary depending on whether
the Network Interface Board is configured as a print server or as a remote print-
er. This section describes how to configure the machine in the NetWare 3.x en-
vironment.

Preparation
The following procedures use the Property Sheet method in configuring the
Network Interface Board. If you configure the Network Interface Board as a
NetWare print server for the first time, we recommend you use the Wizard
method. ⇒ p.43 “Quick Setup Using the NIB Setup Tool Wizard” 

Note
❒ This section assumes NetWare is functional and that the necessary environ-

ment for the NetWare Print Service is available.

Install the NIB Setup Tool

Print Server Remote Printer

Basic Procedure

Configure the Network Interface Board

Configure the NetWare

Start the print server



NetWare 3.x - Advanced Settings

4

Setting Up as a Print Server

AAAA Log on to the file server as a Supervisor or a Supervisor equivalent.

BBBB Run the NIB Setup Tool.

Reference
 ⇒ p.42 “Running the NIB Setup Tool” 

CCCC Click [Property Sheet] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

DDDD Click [IPX protocol].

EEEE Click the IPX address of the Network Interface Board which is to be config-
ured, and then click [Next >].

Note
❒ If you do not know which Network Interface Board you are configuring,

see the network configuration page to check the MAC address (Network
Address).

FFFF Make sure that the MAC address and IPX address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

GGGG Click [Configure].
The property sheet appears.

HHHH Click the [General] tab, and type the name of the print server into the [Device
Name] box.

IIII Click the [NetWare] tab, and make the following settings.

AAAA Select [Bindery].
BBBB In the [File Server Name:] box, type the name of the file server in which a

print server is to be created.
Click [Browse] to select a file server among those listed in the [Browse] dia-
log box.

CCCC Click [OK] to close the property sheet.

DDDD After the confirmation dialog box appears, click [OK].

JJJJ On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

KKKK Type “PCONSOLE” from the command prompt.

F:> PCONSOLE
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LLLL Create a print queue as follows:

Note
❒ If you use a currently defined print queue, go to step M.
AAAA From the [Available Options] menu, select [Print Queue Information] and press

the {{{{ENTER}}}} key.

BBBB Press the {{{{INSERT}}}} key and type a print queue name.
CCCC Press the {{{{ESC}}}} key to return to the [Available Options] menu.

MMMM Create a printer as follows:

AAAA From the [Available Options] menu, select [Print Server Information] and press
the {{{{ENTER}}}} key.

BBBB To create a new print server, press the {{{{INSERT}}}} key and type a print
server name.

If you use a currently defined print server, select one of the print servers
shown in the [Print Server] list.

Important
❒ Use the same name as that specified in the NIB Setup Tool. ( Step H).

CCCC From the [Print Server Information] menu, select [Print Server Configuration].

DDDD From the [Print Server Configuration] menu, select [Printer Configuration].
EEEE Select the printer which is indicated as “Not Installed”.

FFFF If you want to change the name of the printer, type a new name.

A name “Printer x” is assigned to the printer. “x” stands for the number of
the selected printer.

GGGG For type, select [Remote Other/Unkown].
The IRQ, Buffer size, Starting form, and Queue service mode are automat-
ically configured.

HHHH Press the {{{{ESC}}}} key, and click [Yes] in the confirmation dialog box.

IIII Press the {{{{ESC}}}} key to return to the [Print Server Configuration] menu.

NNNN Assign print queues to the created printer as follows:
AAAA From the [Print Server Configuration] menu, select [Queues Serviced By Printer].

BBBB Select the printer created in step MMMM.

CCCC Press the {{{{INSERT}}}} key to select a queue serviced by the printer. 

Note
❒ You can select more than one queue at a time.

DDDD Follow the instructions on the screen to make other necessary settings.

When you have finished the previous steps, make sure that the queues are
assigned.
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OOOO Press the {{{{ESC}}}} key until “Exit?” appears, and select [Yes] to exit PCON-
SOLE.

Note
❒ To make sure that the printer is correctly configured, type the following

from the command prompt.
F:> USERLIST

❒ If the printer works as configured, the name of the print server appears as
an attached user.

Setting Up as a Remote Printer

AAAA Log on to the file server as a Supervisor or a Supervisor equivalent.

BBBB Run the NIB Setup Tool.

Reference
 ⇒ p.42 “Running the NIB Setup Tool” 

CCCC Click [Property Sheet] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

DDDD Click [IPX protocol].

EEEE Click the IPX address of the Network Interface Board which is to be config-
ured, and click [Next >].

Note
❒ If you do not know which Network Interface Board you are configuring,

see a network configuration page to check the MAC address (Network Ad-
dress).

FFFF Make sure that the MAC address and IPX address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

GGGG Click [Configure].
The property sheet appears.

HHHH Click the [General] tab, and type the name of the print server into the [Device
Name] box.
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IIII Click the [NetWare] tab, and make the following settings.

AAAA In the [Print Server Name] box, type the name of the print server.
BBBB In the [File Server Name] box, type the name of the file server in which a

print server is to be created.
Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

CCCC In the [Print Server Operation Mode] group, click [As Remote Printer].

DDDD In the [Remote Printer No.] box, type the printer number.

Important
❒ Use the same printer number as that to be created in the printer server.

EEEE Click [OK] to close the property sheet.
FFFF After the confirmation dialog box appears, click [OK].

JJJJ On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

KKKK Type “PCONSOLE” from the command prompt.
F:> PCONSOLE

LLLL Create a print queue as follows:

Note
❒ If you use a currently defined print queue, go to step M.
AAAA From the [Available Options] menu, select [Print Queue Information] and press

the {{{{ENTER}}}} key.

BBBB Press the {{{{INSERT}}}} key and type a print queue name.

CCCC Press the {{{{ESC}}}} key to return to the [Available Options] menu.

MMMM Create a printer as follows.

AAAA From the [Available Options] menu, select [Print Server Information] and press
the {{{{ENTER}}}} key.

BBBB To create a new print server, press the {{{{INSERT}}}} key and type a print
server name.

If you use a currently defined print server, select one of the print servers
shown in the [Print Server] list.

Important
❒ Use the same name as that specified in the NIB Setup Tool. (Step H).

CCCC From the [Print Server Information] menu, select [Print Server Configuration].

DDDD From the [Print Server Configuration] menu, select [Printer Configuration].
EEEE Select the printer which is indicated as “Not Installed”.

Important
❒ Use the same number as that specified as Remote Printer No. using the

NIB Setup Tool. (Step I-D).



NetWare 3.x - Advanced Settings

4

FFFF Type a new name, if you change the name of the printer, .

A name “Printer x” is assigned to the printer. x stands for the number of
the selected printer.

GGGG Select [Remote Parallel, LPT1,] for type.
The IRQ, Buffer size, Starting form, and Queue service mode are automat-
ically configured.

HHHH Press the {{{{ESC}}}} key, and click [Yes] in the confirmation dialog box.

IIII Press the {{{{ESC}}}} key to return to [Print Server Configuration Menu].

NNNN Assign print queues to the created printer as follows:
AAAA From [Print Server Configuration Menu], select [Queues Serviced By Printer].

BBBB Select the printer created in step MMMM.

CCCC Press the {{{{INSERT}}}} key to select a queue serviced by the printer. 

Note
❒ You can select more than one queue at a time.

DDDD Follow the instructions on the screen to make other necessary settings.

When you have finished the above steps, make sure that the queues are as-
signed.

OOOO Press the {{{{ESC}}}} key until “Exit?” appears, and select [Yes] to exit PCON-
SOLE.

PPPP Start the print server by typing the following from the console of the Net-
Ware Server.
 If it is running, restart it after exiting it.

❖❖❖❖ To exit
CAREE: unload pserver

❖❖❖❖ To start
CAREE: load pserver print_server_name

Note
❒ If the printer works as configured, “Waiting for job” appears.
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NetWare 4.x, 5/5.1 - Advanced Settings

The actual procedures for configuring the machine vary depending on whether
the Network Interface Board is configured as a print server or as a remote print-
er. This section describes how to configure it in the NetWare 4.x, 5/5.1 environ-
ment.

❖❖❖❖ To use NetWare 5/5.1
• If you use Pure IP, configure the machine to use the TCP/IP protocol. For

more information about how to make the settings, see the System Settings.

Preparation
The following procedures use the Property Sheet method in configuring the
Network Interface Board. If you configure the Network Interface Board as a
NetWare print server for the first time, we recommend you use the Wizard
method. ⇒ p.43 “Quick Setup Using the NIB Setup Tool Wizard” 

Note
❒ This section assumes NetWare is functional and that the necessary environ-

ment for the NetWare Print Service is available.
❒ You should install the client software released from Novell in Windows be-

fore running the NIB Setup Tool for configuring in NDS mode or using Win-
dows NT 4.0.

Install the NIB Setup Tool

Print Server Remote Printer

Basic Procedure

Configure the Network Interface Board

Configure the NetWare

Start the print server
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Setting Up as a Print Server

Important
❒ You can set up the print server using the NDS or Bindery mode in NetWare

4.x, 5/5.1. The following procedure is for setting up the print server using the
NDS mode in NetWare 4.1. When you set up the print server using the Bind-
ery mode, use the NIB Setup Tool Wizard. ⇒ p.43 “Quick Setup Using the
NIB Setup Tool Wizard”.

Note
❒ If you use Pure IP in NetWare 5/5.1, follow the procedure on p.55 “Using

Pure IP in the NetWare 5/5.1 environment”.

AAAA Log on to the file server as an Admin or an Admin equivalent.

BBBB Run the NIB Setup Tool.

Reference
 ⇒ p.42 “Running the NIB Setup Tool” 

CCCC Click [Property Sheet] and click [OK].

DDDD Click [IPX protocol].

EEEE Click the IPX address of the Network Interface Board which is to be config-
ured, and click [Next >].

Note
❒ If you do not know which Network Interface Board you are configuring,

see the network configuration page to check the MAC address (Network
Address).

FFFF Make sure that the MAC address and IPX address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

GGGG Click [Configure].

The property sheet appears.

HHHH Click the [General] tab, and type the name of the print server into the [Device
Name] box.

IIII Click the [NetWare] tab, and make the following settings.
AAAA In the [Print Sever Name:] box, type the name of the print sever.

BBBB In the [File Sever Name:] box, type the name of the file sever in which a
print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.
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CCCC In the [NDS Context:] box, type the context in which the print server is to
be created.

Clicking [Browse], you can select a context among those listed in the
[Browse] dialog box.
As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type “NET.DS”.

DDDD Click [OK] to close the property sheet.

EEEE After the confirmation dialog box appears, click [OK].

JJJJ On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

KKKK From Windows, run NWAdmin.

Reference
For more information about NWAdmin, see the documentation that comes
with the NetWare.

LLLL Create a print queue as follows:

AAAA Select the container object the print queue is located in among those in
the directory tree, and click [Create] on the [Object] menu.

BBBB In the [Class of new object] box, click “Print Queue”, and click [OK].

CCCC In the [Print Queue name] box, type the name of the print queue.
DDDD In the [Print Queue volume] box, click the [Browse] button.

EEEE In the [Available objects] box, click the volume in which the print queue is
created, and click [OK].

FFFF After acknowledging the settings, click [Create].

MMMM Create a printer as follows:
AAAA Select the container object the printer is located in, and click [Create] on

the [Object] menu.
BBBB In the [Class of new object] box, click “Printer”, and click [OK]. When you

are using NetWare 5/5.1, click “Printer (Non NDPS)”.
CCCC In the [Printer name] box, type the name of the printer.

DDDD Select the [Define additional properties] check box, and click [Create].
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NNNN Assign print queues to the created printer as follows:

AAAA Click [Assignments], and click [Add] in the [Assignments] group.
BBBB In the [Available objects] box, click the queue created in step LLLL, and click

[OK].
CCCC Click [Configuration], and in the [Printer type] box, select [Parallel] using the

drop-down menu, and then click [Communication]. 
DDDD Click [Manual load] in the [Communication type] group, and click [OK].

EEEE After acknowledging the settings, click [OK].

OOOO Create a print server as follows:
AAAA Select the context specified using the NIB Setup Tool (step IIII-AAAA), and on

the [Object] menu, click [Create].
BBBB In the [Class of new object] box, click “Print Server”, and click [OK]. When

you are using NetWare 5/5.1, click “Print Server (Non NDPS)”.
CCCC In the [Print Server name] box, type the name of the print server.

Important
❒ Use the same name as that specified using the NIB Setup Tool. (Step H)

DDDD Select the [Define additional properties] check box, and click [Create].

PPPP Assign the printer to the created print server as follows.
AAAA Click [Assignments], and click [Add] in the [Assignments] group.

BBBB In the [Available objects] box, click the printer created in step MMMM, and click
[OK].

CCCC After acknowledging the settings, click [OK].

Note
❒ If the printer works as configured, the name of the print server appears

as an attached user.

Using Pure IP in the NetWare 5/5.1 environment

AAAA Log on to the file server as an Admin or an Admin equivalent.

BBBB Run the NIB Setup Tool.

Reference
 ⇒ p.42 “Running the NIB Setup Tool” 

CCCC Click [Property Sheet] and click [OK].

The [Network board list] dialog box appears.

DDDD Click [TCP/IP protocol].
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EEEE Click the IP address of the Network Interface Board which is to be config-
ured, and click [Next >].

Note
❒ If you do not know which Network Interface Board you are configuring,

see the network configuration page to check the MAC address (Network
Address).

FFFF Make sure that the MAC address and IP address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

GGGG Click [Configure].

The property sheet appears.

HHHH Click the [General] tab, and type the name of the print server into the [Device
Name:] box.

IIII Click the [NetWare] tab, and make the following settings.
AAAA In the [Print Server Name:] box, type the name of the print server.

BBBB In the [File Server Name:] box, type the name of the file server in which a
print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse File Server] dialog box.

CCCC In the [NDS Context:] box, type the context of the print server.

Clicking [Browse], you can select an NDS tree and an NDS context among
those listed in the [Browse Context] dialog box.
As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type “NET.DS”.

DDDD In the [Print Server Operation Mode] group, click [As Print Server].

EEEE Click [OK] to close the property sheet.
FFFF After the confirmation dialog box appears, click [OK].

JJJJ On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

After this step, go to step K on p.53 “Setting Up as a Print Server”.
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Setting Up as a Remote Printer

AAAA Log on to the file server as an Admin or an Admin equivalent.

BBBB Run the NIB Setup Tool.

Reference
 ⇒ p.42 “Running the NIB Setup Tool” 

CCCC Click [Property Sheet] and click [OK].

The [NIB Setup Tool - Network board list] dialog box of the Network Interface
Board appears.

DDDD Click [IPX protocol].

EEEE Click the IPX address of the Network Interface Board which is to be config-
ured, and click [Next >].

Note
❒ If you do not know which Network Interface Board you are configuring,

see the network configuration page to check the MAC address (Network
Address).

FFFF Make sure that the MAC address and IPX address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

GGGG Click [Configure].
The property sheet appears.

HHHH Click the [General] tab, and type the name of the print server into the [Device
Name] box.

IIII Click the [NetWare] tab, and make the following settings.

AAAA In the [Print Server Name:] box, type the name of the print server.
BBBB In the [File Server Name:] box, type the name of the file server in which a

print server is to be created.
Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.
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CCCC In the [NDS Context:] box, type the context in which the print server is to
be created.

Clicking [Browse], you can select a context among those listed in the
[Browse] dialog box.
As a context, object names are typed from a lower level object and divided
by a period. For example, if you want to create a print server into NET un-
der DS, type “NET.DS”.

DDDD In the [Print Server Operation Mode] group, click [As Remote Printer].

EEEE In the [Remote Printer No.] box, type the number of the printer.

Important
❒ Use the same number as that of the printer to be created in the print

server.
FFFF Click [OK] to close the property sheet.

GGGG After the confirmation dialog box appears, click [OK].

JJJJ On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

KKKK From Windows, run NWAdmin.

Reference
For more information about NWAdmin, see the documentation that comes
with the NetWare.

LLLL Create a print queue as follows:

AAAA Select the container object the print queue is located in among those in
the directory tree, and click [Create] on the [Object] menu.

BBBB In the [Class of new object] box, click “Print Queue”, and click [OK].
CCCC In the [Print Queue name] box, type the name of the print queue.

DDDD In the [Print Queue Volume] box, click [Browse] button.

EEEE In the [Available objects] box, click the volume in which the print queue is
created, and click [OK].

FFFF After acknowledging the settings, click [Create].

MMMM Create a printer as follows:

AAAA Select the container object the printer is located in, and click [Create] in
the [Object] menu.

BBBB In the [Class of new object] box, click “Printer”, and click [OK]. When you
are using NetWare 5/5.1, click “Printer (Non NDPS)”.
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CCCC In the [Printer name] box, type the name of the printer.

DDDD Select the [Define additional properties] check box, and click [Create].

NNNN Assign print queues to the created printer as follows:

AAAA Click [Assignments], and click [Add] in the [Assignments] group.

BBBB In the [Available objects] box, click the queue created in step LLLL, and click
[OK].

CCCC Click [Configuration], and in the [Printer type] box, select [Parallel] using the
drop-down menu, and then click [Communication]. 

DDDD Click [Manual load] in the [Communication type] group, and click [OK].
EEEE After acknowledging the settings, click [OK].

OOOO Create a print server as follows:

AAAA Select the context specified using the NIB Setup Tool (Step IIII-AAAA), and on
the [Object] menu, click [Create].

BBBB In the [Class of new object] box, click “Print Server”, and click [OK]. When
you are using NetWare 5/5.1, click “Print Server (Non NDPS)”.

CCCC In the [Print Server name] box, type the name of the print server.

Important
❒ Use the same name as that specified using the NIB Setup Tool. (Step H).

DDDD Select the [Define additional properties] check box, and click [Create].

PPPP Assign the printer to the created print server as follows.

AAAA Click [Assignments], and click [Add] in the [Assignments] group.

BBBB In the [Available objects] box, click the queue created in the step MMMM, and
click [OK].

CCCC In the [Printers] group, click the printer assigned in step BBBB , and click
[Printer Number].

DDDD Type the printer number and click [OK].

Important
❒ Use the same number as that specified as Remote Printer No. using the

NIB Setup Tool. (Step I-E).
EEEE After acknowledging the settings, click [OK].

QQQQ Start the print server by typing the following from the console of the Net-
Ware Server.
If it is running, restart it after exiting it.

❖❖❖❖ To exit
CAREE: unload pserver

❖❖❖❖ To start
CAREE: load pserver print_server_name
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Setting Up a Client Computer

This section describes how to set up a client computer when using a NetWare
print server.

Note
❒ This section assumes that the client has NetWare client applications installed

and is correctly configured to communicate with a NetWare print server. If
not, install the necessary applications before starting the setting up proce-
dure.

Windows 95/98/Me

Follow the procedure to set up a Windows 95/98/Me client. 

Preparation
Log on to the NetWare file server before starting the following procedure.

AAAA Install the printer driver you want to use as “Local printer”.

Reference
For more information about installing the printer driver, see the Printer
Unit Type 1027 Printer Reference 1.

Note
❒ Any port can be selected during the installation, however, LPT1 is recom-

mended.

BBBB Click [Start], point to [Settings], and then click [Printers].

CCCC In the [Printers] window, click the icon of the printer you want to use. 

DDDD On the [File] menu, click [Properties].

EEEE Click the [Details] tab, and click [Add Port].

FFFF Click [Network] and click [Browse].

GGGG On the network tree, double-click the name of the file server.

The queues are displayed.

HHHH Click the queue you want to print, and click [OK].

IIII Click [OK].

In the [Print to the following port] box, a network path to the printer appears.

JJJJ Click [OK] to close the Printer Properties, and again, open it.
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KKKK Click the [Printer Settings] tab.

LLLL Select to clear the [Form feed] and [Enable banner] check boxes.

Note
❒ You should not select these boxes because they should be specified using

the printer driver. If they are selected, the printer might not print correctly.

When using the PostScript printer driver

Follow these steps to set up for the PostScript printer driver.
AAAA Click the [PostScript] tab. 

BBBB Click [Advanced].

CCCC Click to clear the [Send CTRL+D before job] and [Send CTRL+D after job] check
boxes.

MMMM Click [OK] to close the Printer Properties.

Windows 2000

Follow the procedure to set up a Windows 2000 client.

Preparation
Log on to the NetWare file server before starting the following procedure.

AAAA Double-click the [My Network Places] icon on the desktop and navigate to the
queue you want to use, and then double-click it.
The printers dialog box appears.

BBBB Click [No].

CCCC Close all the applications that are currently running.

DDDD Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.
If the setup menu starts automatically, you can go to the next step. If not, see
the Printer Unit Type 1027 Printer Reference 1.

EEEE The [Printer Installation] dialog box appears.

FFFF From the [Port] list, select the queue you selected in step AAAA, and click [Next >].

GGGG Follow the instructions on the screen to complete the installation of the
printer driver.
61



NetWare Configuration

62

4

Windows NT 4.0

Follow the procedure to set up a Windows NT 4.0 client.

Preparation
Log on to the NetWare file server before starting the following procedure.

AAAA Double-click the [Network Neighborhood] icon on the desktop and navigate to
the queue you want to use, and then double-click it.
The [Printers] dialog box appears.

BBBB Click [No].

CCCC Close all the applications that are currently running.

DDDD Insert the CD-ROM labeled “Printer Drivers and Utilities”into the CD-
ROM drive.
If the setup menu starts automatically, you can go to the next step. If not, see
the Printer Unit Type 1027 Printer Reference 1.

EEEE The [Printer Installation] dialog box appears.

FFFF From the [Port] list, select the queue you selected in step AAAA, and click [Next >].

GGGG Follow the instructions on the screen to complete the installation of the
printer driver.



5. Macintosh Configuration
Configuring Macintosh

This section describes how to configure a Macintosh computer to use EtherTalk.
The actual procedures to configure a Macintosh may vary depending on the ver-
sion of the Mac OS. The following procedure describes how to configure Mac OS
9.1. If you are not using Mac OS 9.1, see the manual that comes with your version
of Mac OS for more information.

Limitation
❒ Use PostScript 3, to print from a Macintosh.

Changing to EtherTalk

The following procedure is for configuring a Macintosh computer to use
EtherTalk.

Reference
For more information about installing the software required for EtherTalk,
see the Macintosh manuals.

AAAA Open [Control Panel], and double-click the [AppleTalk] icon.

BBBB From the [Connect via:] pop-up menu, select “Ethernet”.

CCCC If you change zones, select a name from the [Current zone:] pop-up menu.

DDDD Close the [AppleTalk] control panels.

EEEE Restart the Macintosh.

Change to EtherTalk

Basic Procedure

Configure the printer

Change the printer name

Change the zone
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Configuring the Printer

Use the control panel to activate the EtherTalk protocol. (The default is active.)

Reference
For more information about configuration, see the System Settings.

Changing the Printer Name

If the network has several similar model printers, the names will be the same.
Printers that have the same name will have their names slightly changed in the
Chooser. For example, three printers named “printer” will appear in the chooser
as “printer0”, “printer1” and “printer2”. 
To change the printer name in the Macintosh EtherTalk environment, use the
Printer Utility for Mac included on the CD-ROM labeled “Printer Drivers and
Utilities”.

Changing the Zone

To change the zone configuration in the Macintosh EtherTalk environment, use
the Printer Utility for Mac included on the CD-ROM labeled “Printer Drivers
and Utilities”.

Reference
For more information about using Printer Utilities for Mac, see PostScript 3
Unit Type 1027 Operating Instructions Supplement provided as a PDF file on
the CD-ROM labeled “Operating Instructions for Printer”.



6. Appendix
Configuring the Network Interface Board 
with a Web Browser

The Network Interface Board functions as a Web server in addition to allowing
a printer to function as a network printer. You can use a Web Browser to view
the printer status and configure the Network Interface Board.

❖❖❖❖ Configuring the machine
This requires the TCP/IP protocol to be installed. After the machine has been
configured to use the TCP/IP protocol, it will be possible to adjust the settings
using a Web Browser.

Reference
For more information about configuring the machine to use the TCP/IP
protocol, see the System Settings.

❖❖❖❖ Operating system browser requirements

Limitation
❒ Sometimes after clicking [Back] , the previous page may not appear. In this

case, click [Refresh] or [Reload] .
❒ The text on the screen may disappear or be aligned incorrectly if the font

size settings of the browser are too large. It is recommended that you use
a font size equal to or smaller than “10 point” with Netscape Navigator,
and “Medium” or smaller with Internet Explorer.

OS Browser

Windows 95/98/Me

Microsoft Internet Explorer 3.02 or later

Netscape Navigator 4.0 or later

Windows NT 4.0

Windows 2000

Mac OS 8.6 ∼ 9.1

Solaris 2.5/2.6/2.7/7/8
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Going to the Top Page

After launching the Web Browser, type the IP address of the machine. See the
example below. This example is for the English version.
http://192.168.15.16/

(In this example, the IP address of the Network Interface Board is 192.168.15.16.)

Note
❒ If a DNS server is used on the network, you can type the host name as a URL.

For example, http://webmonitor.netprinter.com/. In order to do this, you
must the register the IP address and the host name of the Network Interface
Board with the DNS server. Consult the network administrator for informa-
tion about how to do this.

❒ When a proxy server is used on the network, specify the proxy server on the
browser.

1. Header Buttons
You can register favorite URLs with
[URL]. To view the Help section, click
[Help].

Important
❒ When connecting via a dial-up

connection, please be aware that
there will be a communication
charge as you are logging onto the
Internet.

Note
❒ The Help files are stored on the CD-

ROM labeled “Operating Instructions
for Printer” in HTML format.

2. Menu Buttons
These Buttons are to configure the Net-
work Interface Board and for checking
the status of the machine.

Note
❒ When you click [Configuration], a dia-

log box appears requesting the user
name and password. Type only the
password in this dialog box. The de-
fault password is “password”.

❒ The password is the same as that used
for remote maintenance and that used
in the NIB Setup Tool. If you change a
password with the Web Browser, the
other passwords are also changed.

3. Status
Displays the name and comments of the
Network Interface Board, and the printer
status.

3

1
2
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----Linking the address (URL) to the [Help] button
You can link the address (URL) of the [Help] button to the Help files on the com-
puter or on a Web server.
A Copy the Help files on the CD-ROM to the desired location. The Help files are

located in folders labeled with abbreviated language names; for example,
English Help files are in the [EN] folder. Make sure to copy the entire [EN] fold-
er to the new location.

B Using a Web Browser, navigate to the Top Page and click [Network config].
C Type your password, (it is not necessary to type a user name) and click [OK].
D Type the path to the Help files in the [Help URL] box.

If you copied the Help files to “C:\HELP\EN”, type “file ://C:/HELP/”.
For example if you copied the files to a web server and the index URL is
“http://a.b.c.d/HELP/EN/index.html”, type “http://a.b.c.d/HELP/”.

E Click [Apply].
When a warning message appears, select to continue configuration.
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Remote Maintenance by telnet

You can view the printer status and configure the Network Interface Board us-
ing telnet.

Note
❒ You should specify a password so that only the network administrator, or a

person having network administrator privileges, can use remote mainte-
nance. 

Using telnet

The following is a sample procedure using telnet.

Limitation
❒ Only one person at a time can be logged on to do remote maintenance.

AAAA Using the IP address or host name of the machine, start telnet.

% telnet IP_address

Note
❒ In order to use the host name instead of the IP address, you must write it

to the /etc/hosts file.

BBBB Type the password.

Note
❒ The default is “password”.

CCCC Type a command.

Reference
 For more information about telnet commands, see p.69 “Commands List”.

DDDD Exit telnet.

msh> logout

When the configuration is changed, a message requests whether or not the
changes should be saved.

EEEE Type “yes” to save the changes, and press the {{{{ENTER}}}} key.
If you do not want to save the changes, type “no”and press the {{{{ENTER}}}} key.
If you want to make additional changes, type “return” at the command line,
and press the {{{{ENTER}}}} key.
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Note
❒ If the “Cannot write NVRAM information” message appears, the changes

are not saved. Repeat the steps above.
❒ The Network Interface Board is reset automatically when the settings are

changed.
❒ When the Network Interface Board is reset, the active print job which has

already been sent to the machine will finish printing. However, jobs that
have not been sent yet will be canceled.

Commands List

This is a list of commands that can be used via remote maintenance.

Note
❒ Type “help” to see a list of commands that can be used.

msh> help

❒ Type “help command_name” to display information about the syntax of that
command.
msh> help command_name

TCP/IP address

Use the ifconfig command to configure TCP/IP(IP address, subnet mask, broad-
cast address, default gateway address) for the machine.

❖❖❖❖ Reference
msh> ifconfig

❖❖❖❖ Configuration
msh> ifconfig naf0 parameter address

The following is an example for configuring an IP address of 192.168.15.16.
msh> ifconfig naf0 192.168.15.16

The following is an example for configuring a subnet mask of 255.255.255.0.
msh> ifconfig naf0 netmask 255.255.255.0

Note
❒ This affects the configuration of the Network Interface Board of the IP ad-

dress that is used.
❒ To type an address using hexadecimal, prefix it by “0x”.

Parameter Meaning
(no parameter) IP address
 netmask subnet mask
 gateway default gateway address
broadcast broadcast address
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----Address

❖❖❖❖ Subnet Mask
A number used to mathematically “mask” or hide the IP address on the net-
work by eliminating those parts of the address that are alike for all the ma-
chines on the network.

❖❖❖❖ Default Gateway Address
A gateway is a connection or interchange point that connects two networks.
A gateway address is used as a gateway by the router or host computer .

Note
❒ To get the above addresses, contact your network administrator.

Access Control

Use the access command to view and configure access control.

❖❖❖❖ Reference
msh> access

❖❖❖❖ Configuration
msh> access parameter address

Note
❒ The Access Control Address and the Access Control Mask are used to limit

access to the computer used for printing by denying access to users based on
their IP address. If it is not necessary to limit access, set the Access Control
Mask to “0.0.0.0”.

❒ When the Access Control Address matches the masked result of the IP ad-
dress computer attempting to print, print jobs from that IP address will be ac-
cepted by the Network Interface Board.

Parameter Meaning

 control Access Control Address

 mask Access Control Mask
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❒ For example, if you assign 192.168.15.16 as the Access Control Address of the
Network Interface Board, the IP addresses that can print are as follows: XXX
means any number from 1 to 254 is acceptable. 

Network Boot

Use the set command to configure the boot method.
msh> set parameter {on | off}

 “on” means active and “off” means inactive.

Note
❒ When you use DHCP, the server also needs to be configured.
❒ DHCP takes precedence over all other settings.

Access Control Mask IP addresses that can access the 
printer

  0.  0.  0.  0 XXX.XXX.XXX.XXX

255.  0.  0.  0 192.XXX.XXX.XXX

255.255.  0.  0 192.168.XXX.XXX

255.255.255.  0 192.168. 15.XXX

255.255.255.255 192.168. 15. 16

Parameter Meaning

 dhcp DHCP (Dynamic Host Configuration 
Protocol)
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Protocol

Use the set command to allow/prevent remote access for each protocol.
msh> set protocol {up | down}

Note
❒ If you prohibit remote access using TCP/IP and then log out, you cannot use

remote access. If this was a mistake, you can use the control panel to allow ac-
cess by TCP/IP.

❒ When you prevent access via TCP/IP, you are also prevented from using lpr,
ftp, rsh, diprint, web, snmp and ipp.

Printer status

The following commands can be used to get information about the current status
of the printer.
msh> command

Note
❒ More information about any print job is displayed when the ID number is

added after the prnlog command.

Reference
For more information about the meaning of the data returned with these com-
mands, see p.81 “Configuring the Network Interface Board”.

Protocol

 appletalk 

 tcpip 

 netware 

 netbeui 

 lpr 

 ftp 

 rsh 

 diprint 

 web 

 snmp 

 ipp 

“up” means active and “down” means 
inactive.

Command Information that is displayed

 status Status of printer.

Information about the print jobs.

 info Information about the paper tray, output tray, 
printer language of printer.

 prnlog [ID] Lists the last 16 print jobs.
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Network Interface Board configuration settings information

Use the show command to display the Network Interface Board configuration
settings.
msh> show [-p]

Note
❒ Add “-p” to the show command to have the information displayed one screen

at a time.

Reference
For more information about the meaning of the data returned with this com-
mand, see p.81 “Configuring the Network Interface Board”.

System log information

Use the syslog command to display information stored in the machine's system
log. 
msh> syslog

Reference
For more information about the displayed information, see p.84 “System Log
Information”.

SNMP

Use the snmp command to display and edit SNMP configuration settings such
as the community name.

Note
❒ You can configure from ten SNMP access settings numbered 1–10.
❒ Default access settings 1 and 2 are as follows.

❖❖❖❖ Display
Shows the SNMP information and available protocols.
msh> snmp ?
msh> snmp [-p] [registered_number]

Note
❒ If the -p option is added, you can view the settings one by one.
❒ Omitting the number displays all access settings.

Number 1 2

Community name  public admin

IP address 0.0.0.0 0.0.0.0

Access type  read-only 

 trap off

 read-write 

 trap off
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❖❖❖❖ Community name configuration
You can set the community name of the registered number.
msh> snmp number name community_name

Note
❒ The community name must consist of 15 characters or less.

❖❖❖❖ Access type configuration
You can select the access type from those listed below.
msh> snmp number type access_type

❖❖❖❖ Protocol configuration
You should use the following command to set the protocols to active or inac-
tive. If you set a protocol to inactive, all access settings set to use that protocol
will be disabled.
msh> snmp {ip | ipx} {on | off}

•  “on” means active and “off” means inactive
To change the protocol of an access settings, use the following command.
However, if you disabled a protocol with the above command, making it ac-
tive here will have no effect.
msh> snmp number active {ip | ipx} {on | off}

❖❖❖❖ Access configuration
You can configure the address of a host depending on the protocols used. 
The Network Interface Board accepts requests only from hosts having ad-
dresses with access types of “read-only” or “read-write”. Type “0” to have the
Network Interface Board accept requests from any host without requiring a
specific type of access.
Command syntax:
msh> snmp number {ip | ipx} address

Note
❒ To specify the TCP/IP protocol, type ip followed by a space, and then the

IP address.
❒ To specify the IPX/SPX protocol, type ipx followed by a space, and then

the IPX address followed by a decimal, and then the MAC address of the
Network Interface Board.

Access type Type of access which is permitted

 read Read only

 write Read and write

 trap User is notified of trap messages.

 no All access is denied.
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The following is an example of how to configure registration number 3 with
the IP address 192.168.15.16.
msh> snmp 3 ip 192.168.15.16
The following is an example of how to configure registration number 3 with
the IPX address 7390A448, and the MAC address 00:00:74:62:5C:65.
msh> snmp 3 ipx 7390A448:000074625C65

IPP

Use the ipp command to configure the IPP settings.

❖❖❖❖ Viewing setting
The following command displays the current IPP settings.
msh >ipp
Example output:
timeout=900(sec)
auth basic

• The “timeout” setting specifies how many seconds the computer keeps try-
ing to access the network printer to send print jobs when no connection can
be made.

• The “auth” setting indicates the user authorization mode.

❖❖❖❖ IPP timeout configuration 
Specify how many seconds to wait before canceling a print job if it has been
interrupted for some reason. The range of time can be changed between 30 to
65535 seconds.
msh>ipp timeout {30 - 65535}

❖❖❖❖ IPP user authorization configuration
Use the IPP user authorization to restrict users that can print with IPP. The de-
fault is “off” .
ipp auth {basic|digest|off}

• “basic” and “digest” are user authorization setting.
• “off” removes the user's authorization.

Note
❒ If you select “basic” or “digest”, see next section “Entry the IPP User Au-

thorization” for how to configure the user name. Up to ten user names are
available.
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❖❖❖❖ Configuring the IPP user authorization
Use the following command:
ipp user
The following message appears.
Input user number (1 to 10):
Type the number, user name and password.
IPP user name:user1
IPP password:*******
After configuring the settings, the following message appears.
User configuration changed.

Direct Printing Port

The direct printing port allows printing directly from a computer, connected to
the network, to the printer.
Use the diprint command to change the direct printing port settings.

❖❖❖❖ View settings
Ther following command displays the current direct printing port settings.
msh> diprint
Example output:
port 9100
timeout=300(sec)
bidirect off

• The “Port” specifies the port number of the direct printing port.
• The “bidirect” setting indicates whether the direct printing port is bidirec-

tional.

❖❖❖❖ Bidirectional configuration for the direct printing port
Use this setting to configure whether the direct printing port is bidirectional.
The factory default is “off”.
msh> diprint bidirect {on|off}

Note
❒ If you select “on”, SmartNetMonitor for Client or Standard TCP/IP on

Windows 2000 might not work correctly.
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SMB

Use the smb command to configure or delete the computer name or workgroup
name for NetBEUI.
msh >smb parameter

ROUTE

Use the route command to control the routing table.
This command allows you to configure and display routing information. You
can change the network configuration from remote PCs using this command.

Note
❒ The maximum number of routing tables are 16.

*1 IP address

Parameter Settings

smb comp Your computer name consisting of up to 13 characters

smb group Workgroup name consisting of up to 15 characters

smb comment Comment consisting of up to 31 characters

smb clear comp Clears the computer name

smb clear group Clears the Workgroup name

smb clear comment Clears comment

Parameter Topics of setting

route add {host | net} desti-
nation *1  gateway *1 

Adds a host/network route to “destination”, and a gateway ad-
dress to “gateway” in the table. Host becomes the default setting.

route delete {host | net} 
destination *1 

Deletes a host/network route from the table. Host becomes the 
default setting.

route get {destination *1 } Displays only route information corresponding to a specified 
destination. When the destination is unspecified, all routing in-
formation is displayed.

route active {host | net} des-
tination *1  on/off

You can turn the specified destination on or off. Host becomes 
the default setting.

route flush Deletes all routing information.
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SLP

Use this command to configure SLP settings.
You can search the NetWare server using SLP in the PureIP environment of
NetWare5/5.1. To use the slp command, you can configure the value of TTL
which can be used by the SLP multi-cast-packet.

Note
❒ The default value of TTL is “1”. A search is executed only within a local seg-

ment. If the router does not support multi-cast, the settings are not available
even if the TTL value is increased.

❒ The acceptable TTL value is 1 - 255.
msh> slp ttl {1 - 255}

Changing the password

Use the passwd command to change the remote maintenance password.

Important
❒ Be sure not to forget or lose the password.

Note
❒ The default password is “password”.

AAAA Type “passwd”.

msh> passwd

BBBB Type the current password.
Old password:

CCCC Type the new password.

New password:

Note
❒ The password must consist of 3 to 8 alphanumeric characters and symbols.

Upper and lower case characters are considered unique. For example, R is
different from r.

❒ The password is the same as that used in the configuration of the Network
Interface Board using a Web Browser and that used in the NIB Setup Tool.
If you change a password from telnet, the other passwords are also
changed.

DDDD Type the new password once again.
Retype new password:
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SNMP

The Network Interface Board functions as an SNMP (Simple Network Manage-
ment Protocol) agent using the UDP and IPX protocols. Using the SNMP man-
ager you can get information about the printer.
The default community names are “public” and “admin”. You can get MIB in-
formation using these community names.

Reference
For more information about configuring the community name, see p.73
“SNMP” in “Remote Maintenance by telnet”.

Limitation
❒ The kinds of supported MIBs vary depending on the printer.

❖❖❖❖ Supported MIBs
•  MIB-II 
•  PrinterMIB 
•  HostResourceMIB 
•  RicohPrivateMIB 
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Understanding the Displayed Information 

This section describes how to read the status information returned by the Net-
work Interface Board.

Print Job Information

The status of the print job can be viewed using the following commands.
• telnet : Use the status command. ⇒ p.72 “Printer status” 

Print Log Information

This is a record of the most recent 16 jobs that have been printed.
This log can be displayed with the following commands.
• telnet : Use the prnlog command. ⇒ p.72 “Printer status” 

Item name Meaning

Rank Print job status.

• Active
Printing or preparing for printing.

• Waiting
Waiting to be transferred to the printer.

Owner Print request user name.

Job Print request number.

Files The name of the document.

Total Size The size of the data (spooled).

The default is “0 bytes”.

Name Meaning

ID Print request ID.

User Print request user name.

Page The number of pages that is printed.

Bytes The number of bytes that is received.

Result The result of the print request.

Time The time when the print request was received

User ID User ID that is to be configured in the printer driver.

JobName The name of the document for printing.



Understanding the Displayed Information

6

Configuring the Network Interface Board

The Network Interface Board settings can be displayed by using the commands
below.
• telnet : Use the show command. ⇒ p.73 “Network Interface Board configura-

tion settings information” 

Item name Meaning

 Common 

 Mode 

 Protocol Up/Down 

 AppleTalk 

 TCP/IP 

 NetWare 

 NetBEUI 

Ethernet interface

NVRAM version 

 Device name 

 Comment 

 Location 

 Contact 

 Soft switch 

 

 

Up means active, Down means inactive.

 

 

 

 

 

Internal version number.

 AppleTalk 

 Mode 

 Net 

 Object 

 Type 

 Zone 

 

AppleTalk protocol in selection.

Network number.

Macintosh printer name.

The type of printer.

Name of the zone that the printer belongs to.
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 TCP/IP 

 Mode 

 ftp 

 lpr 

 rsh 

 diprint 

 web 

 telnet 

 snmp

 ipp

 EncapType 

 Network boot 

 Address 

 Netmask 

 Broadcast 

 Gateway 

 AccessCtrl 

 AccessMask 

 Time server 

 Home page URL 

 Home page link name 

 Help page URL 

 SNMP protocol 

 

Up means active, Down means inactive. 

 

 

 

 

 

 

 

 

Frame type.

Network boot.

IP address.

Subnet mask.

Broadcast address.

Default gateway address.

Access control address.

Access control mask.

 

URL of homepage.

URL name of homepage.

URL of help page.

Protocol used with SNMP.

 NetWare 

 EncapType 

 RPRINTER number 

 Print server name 

 File server name

 Context name 

 Switch 

 Mode 

 NDS/Bindery 

 Packet negotiation 

 Print job timeout 

 

Frame type.

Remote printer number.

Print server name.

Name of the connect file server.

Context of print server.

 

Active mode.

(this value is fixed)

 

Time of the job timeout.

Item name Meaning
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 NetBEUI 

 Switch 

 Mode 

 diprint 

 Notification 

 Workgroup name 

 Computer name 

 Comment 

 Share name[1] 

 

 

(this value is fixed)

(this value is fixed)

Notification of print job completion.

Name of the workgroup.

Name of the computer.

Comment.

Share name (name of the printer type).

 Shell mode Mode of the remote maintenance tool.

Item name Meaning
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Message List

This is a list of messages written to the machine's system log. The system log can
be viewed using the syslog command.

System Log Information

You can use the following methods to view the system log.
• UNIX : Use the syslog paremeter of rsh, rcp or ftp command. 

Note
❒ Concerning UNIX printing information, please visit our web site or consult

your authorized reseller.
• telnet : Use the syslog command. ⇒ p.73 “System log information” 

Message Description and Solutions

Access to NetWare server <file server name> 
denied. Either there is no account for this print 
server on the NetWare server or the password 
was incorrect. 

(In print server mode) Cannot log in to the file 
server. Make sure that the print server is resis-
tered on the file server. If a password is speci-
fied for the print server, delete it.

add_sess: community<community name> 
already defined.

The same community name already exists. 
Use another community name.

add_sess: session<community name> not de-
fined.

A requested community name is not defined.

add_sess: bad trap addr:<IpAddress>, com-
munity:<community name>

The IP address (0.0.0.0.) is unavailable when 
the community access type is TRAP. Specify 
the host IP address for the TRAP destination.

add_sess_ipx: bad trap addr: <IPX address>, 
community:<community name>

The IPX address (00:00:00:00:00:00) is unavail-
able when the community access type is 
TRAP. Specify the host IPX address for the 
TRAP destination.

add_sess_ipx: community <community name> 
already defined.

The same community name already exists. 
Use another community name.

add_sess_ipx: session_ipx<community name> 
not defined.

A requested community name is not defined.

ANONYMOUS FTP LOGIN FROM 
<IP address>, <password>

An anonymous login has been made with a 
password <password> from the host <IP ad-
dress>.

anpd start. (AppleTalk) An anpd (AppleTalk Network Package Dae-
mon) has started.

Attach FileServer =<file server name> Attached to the file server as a nearest server.

Attach to print queue <print queue name> (In print server mode) Attached to the print 
queue name.
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Cannot create service connection (In remote printer mode) Cannot establish a 
connection with the file server. The number of 
file server users may exceed the maximum 
number that the file server can handle.

Cannot find rprinter (<print server 
name>/<printer number>)

The printer having the number displayed on 
the print server does not exist. Make sure that 
the number of the printer is registered in the 
print server.

Change IP address from DHCP Server. The IP address changes when DHCP LEASE is 
renewed. To always assign the same IP address, 
set a static IP address to the DHCP server.

child process exec error! (process name) Failed to start the network service. Turn the 
printer off and then on. If this does not work, 
contact your service or sales representatives.

Connected DHCP Server(<DHCP server ad-
dress>).

The IP address was successfully received from 
the DHCP server.

connection from <IP address> Logged on from the host <IP address>.

Could not attach to FileServer<error number> (In remote printer mode) Cannot attach to the 
file server. For some reason, the file server 
refuses the connection. Check the file server 
configuration.

Could not attach to PServer<print server> (In remote printer mode) Cannot attach to the 
print server. For some reason, the print server 
refuses the connection. Check the print server 
configuration.

Current Interface Speed:xxxMbps The speed of the network (10 Mbps or 100 Mbps).

Current IP address <current IP address> The IP address <current IP address> was re-
ceived from the DHCP server.

Current IPX address<IPX address> The current IPX address.

DHCP lease time expired. DHCP lease time has expired. The printer tries 
to discover the DHCP server again. The IP ad-
dress used up to now becomes invalid.

DHCP server not found. The DHCP server cannot be found. Make sure 
the DHCP server is running on the network.

dhcpcd start. A dhcpcd (DHCP client service) has started.

Duplicate IP=<IP address>(from <MAC ad-
dress>).

The same IP address is used. An IP address 
must be unique. Check the address of the de-
vice indicated in <MAC address>.

Established SPX Connection with PServer,
(RPSocket=<socket number>, connID=<con-
nection ID>)

(In remote printer mode) A connection with 
the print server has been established.

exiting lpd service has ended and the system is exiting 
the process.

Message Description and Solutions
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Exit pserver (In print server mode) Exits the print server 
because the necessary print server settings 
have not been made.

Frametype =<frame type name> The <frame type name> is configured to be 
used on NetWare.

httpd start. An httpd has started.

inetd start. An inetd has started.

ipp disable. Printing with ipp is disabled.

ipp enable. Printing with ipp is enabled.

LeaseTime=<lease time>(sec), RenewTime=
<renew time>(sec).

The resource lease time that was received from 
the DHCP server is <lease time> in seconds. 
The renewal time is also <renew time> in sec-
onds.

Login to fileserver <file server name> 
(<IPX|IP>,<NDS|BINDERY>) 

(In print server mode) Logged in to the file 
server with NDS or BINDERY mode.

multid start. Data transmission service for multiprotocols 
has started.

nbstart start. (NetBEUI) The service for NetBEUI protocol stack setting 
has started.

NBT Registration Broadcast(<NetBIOS name>) Use a local broadcast to map <NetBIOS name> 
with the IP address.

nbtd start. A nbtd (NetBIOS over TCP/IP Daemon) has 
started. (Available only in DHCP mode)

NetBEUI Computer Name =<computer name> The NetBEUI Computer Name is defined as 
<computer name>.

nmsd start. (NetBEUI) A nmsd (Name Server Daemon) has started.

npriter start. (NetWare) (In remote printer mode) NetWare service has 
started.

nwstart start. (NetWare) The service for NetWare protocol stack setting 
has started.

Open log file <file name> (In print server mode) The specified log file 
has been opened.

papd start. (AppleTalk) AppleTalk print service has started.

phy release file open failed. Replacing the Network Interface Board is re-
quired. Contact your sales or service repre-
sentatives.

Print queue <print queue name> cannot be 
serviced by printer 0, <print server name>

(In print server mode) The print queue name 
cannot be serviced. Make sure that print queue 
volume exists on the specified file server.

Message Description and Solutions
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Print server <print server name> has no print-
er.

(In print server mode) The printer object is not 
assigned to the print server <print server 
name>. Using NWAdmin, assign the printer 
object, and then restart the printer device. 

Print session full Cannot accept the print session.

Printer <printer name> has no queue (In print server mode) The print queue is not 
assigned to the printer. Using NWAdmin, as-
sign the print queue to the printer, and then re-
start it.

pserver start. (NetWare) (In print server mode) NetWare service has 
started.

Required computer name (<Computer name>) 
is duplicated name 

The same computer name is detected on the 
network. The start job determines the compu-
ter name by adding the computer name to the 
suffix (0,1....). Configure a new computer 
name that is unique.

Required file server (<file server name>) not 
found 

Cannot find the required file server.

restarted. LPD has started.

sap enable, saptype=<SAP type>, sapname=
<SAP name>

The SAP function has started. The SAP (SAP 
type and SAP name) packet is issued to adver-
tise the service on the SAP table on the Net-
Ware server.

Set context to <NDS context name> A <NDS context name> has been set. 

shutdown signal received. network service re-
booting...

Rebooting the network service.

smbd start. (NetBEUI) An smbd (SMB (Server Message Block) serv-
ice) has started.

Snmp over ip is ready. Communication over TCP/IP with SNMP is 
available.

Snmp over ipx is ready. Communication over IPX with SNMP is avail-
able.

snmpd start. SNMP service has started.

started. Direct print service has started.

The print server received error <error number> 
during attempt to log in to the network.Access 
to the network was denied.Verify that the print 
server name and password are correct. 

Cannot log in to the file server. The print serv-
er is not registered or the password is speci-
fied. Register the print server without 
specifying a password.

win2kspd started. SCSI print (SBP-2) service has started.

Message Description and Solutions
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Precautions

Please pay attention to the following when using the Network Interface Board.
When configuration is necessary, follow the appropriate procedures below.

Connecting a Dial-Up Router to a Network

When the NetWare file server and the printer are on the opposite side of a router,
packets are continuously sent back and forth, possibly causing communications
charges to increase. Because the packet transmission is a specification of Net-
Ware, you need to change the configuration of the router. If the network you are
using does not allow you to configure the router, configure the machine.

Configuring the router

Filter the packets so that they do not pass over the dial-up router.

Note
❒ The MAC address of the printer doing the filtering is printed on the printer

configuration page. For more information about printing a configuration
page, see the Printer Unit Type 1027 Printer Reference 2.

❒ For more information about configuring the printer if the router cannot be
configured, see the instructions below.

Configuring the printer with NetWare

AAAA Following the setup method in this manual, configure the file server.

BBBB Set the frame type for a NetWare environment.

Reference
For more information about selecting a frame type, see the System Settings.

Configuring the printer without NetWare

AAAA While not printing, the Network Interface Board sends packets on the net-
work. Set the NetWare to inactive.

Reference
For more information about selecting a protocol, see the System Settings.
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PostScript Printing from Windows

When printing PostScript from Windows, see the PostScript 3 Unit Type 1027
Operating Instructions Supplement provided as a PDF file on the CD-ROM la-
beled “Operating Instructions for Printer”.

NetWare Printing

Form Feed

You should not configure the form feed on NetWare. The form feed is controlled
by the printer driver on Windows. If the NetWare form feed is configured, the
printer might not work properly. If you want to change the form feed setting, al-
ways configure it on Windows.
• With Windows 95/98/Me, clear the [Form feed] check box on the [Printer Set-

tings] tab in the printer properties dialog box.
• With Windows 2000, clear the [Form feed] check box on the [NetWare Settings]

tab in the printer properties dialog box.
• With Windows NT 4.0, clear the [Form feed] check box on the [NetWare Settings]

tab in the printer properties dialog box.

Banner Page

You should not configure a banner page on NetWare. If you want to change the
banner page setting, always configure it on Windows. 
• With Windows 95/98/Me, clear the [Enable banner] check box on the [Printer

Settings] tab in the printer properties dialog box.
• With Windows 2000, clear the [Enable banner] check box on the [NetWare Set-

tings] tab in the printer properties dialog box.
• With Windows NT 4.0, clear the [Enable banner] check box on the [NetWare Set-

tings] tab in the printer properties dialog box.

Printing after resetting the machine

After resetting the remote printer, the connection from the print server will be
cut off for about 30-40 seconds before re-connecting. Due to the NetWare speci-
fication, print jobs may be accepted, but they will not be printed during this in-
terval.
When using the machine as a remote printer, wait about 2 minutes after resetting
the printer before attempting to print. 
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When Using DHCP

Note the following points when using DHCP (Dynamic Host Configuration Pro-
tocol).

Supported systems

Microsoft DHCS Server as a standard accessory of Windows 2000 or Windows
NT 4.0;
DHCS Server as a standard accessory of NetWare 5/5.1
DHCP Server as a standard accessory of Solaris 7/8 or RedHat Linux 6.2/7

Configure the printer with a reserved IP address

To always assign the same IP address, configure a reserved IP address using the
DHCP server.

Note
❒ When multiple DHCP servers are used, reserve the same address with each

DHCP server. The Network Interface Board needs to receive information
from the DHCP server that it contacts.

Follow these steps to configure the printer with a reserved IP address.

AAAA Start the DHCP manager.

BBBB Select the scope that will be used, and on the [Scope] menu, click [Reserva-
tion].

CCCC Type the IP address into [IP Address].

DDDD Type the MAC address of the Network Interface Board into [Unique Identifier].

Note
❒ Do not use hyphens to separate the numbers.
❒ If you do not know the MAC address, it can be found on the configuration

page printed by the printer.

EEEE Type a name and comment into the [Client Name] box and the [Client Comment]
box.

Note
❒ For more information about client names, see p.91 “Additional informa-

tion”.

FFFF Click [Add].

An IP address is reserved.

GGGG Click [Close] to close the dialog box.



Precautions

6

Additional information

• When you click [Active Lease] on the [Scope] menu of DHCP manager, a list of
client leases appears. When the reserved IP address is not active, the name of
the reservation is the name entered in the Client Name field of the [Add Re-
served Clients] dialog box. When the reserved IP address becomes active, the
client name changes to the printer name configured by the Network Interface
Board. Only the first 13 letters of the printer name appear here. When you use
the printer with SmartNetMonitor for Client, use the host name of the printer
as the [Client Properties] dialog box.

• When the DHCP server does not assign an IP address, the Network Interface
Board uses 11.22.33.44 as a temporary IP address. You can check the ma-
chine's IP address on the network configuration page.

• Because 11.22.33.44 is a special IP address, you cannot print using this ad-
dress.

• The DHCP relay agent is not supported. When using the DHCP relay agent
via an ISDN line connection, the packets from the printer will be sent through
the ISDN connection, which can lead to very high communication charges.

When Using the NIB Setup Tool 

If the Network Interface Board cannot browse using the TCP/IP protocol, make
sure that the TCP/IP environment is correctly configured in your computer.

When Using IPP with SmartNetMonitor for Admin 

When using IPP with SmartNetMonitor for Admin, note the following:
• The network printer can only receive one print job from SmartNetMonitor for

Admin at a time. While the network printer is printing a job, another user can-
not access the network printer until it completes the job. In this case, Smart-
NetMonitor for Admin tries to access the network printer until the retry
interval expires.

• If SmartNetMonitor for Admin cannot access the network printer and times
out, SmartNetMonitor for Admin stops sending the print job. In this case, you
should cancel the paused status from the print queue window. SmartNet-
Monitor for Admin will resume access to the network printer. You can delete
the print job from the print queue window, but canceling a print job that has
been printed by the network printer might cause the next print job sent from
another user to be incorrectly printed.

• If a print job that is sent from SmartNetMonitor for Admin is interrupted and
the network printer cancels the job because something went wrong, launch
the print job again.

• Print jobs sent from another computer do not appear in the print queue win-
dow regardless of the protocol.
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• If various users send print jobs using SmartNetMonitor for Admin to network
printers, the printing order might not be in the order in which the jobs were
sent.

• An IP address cannot be used for the IPP port name because the IP address is
used for the SmartNetMonitor for Admin port name.
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Specifications

LAN interface 100BASE-TX, 10BASE-T

Frame type EthernetII, IEEE802.2, IEEE802.3, SNAP

Protocol • TCP/IP
Windows 95
Windows 98
Windows Me
Windows 2000
Windows NT 4.0

• IPX/SPX
NetWare 3.12, 3.2, 4.1, 4.11, 4.2, 5, 5.1 IntranetWare

• NetBEUI
Windows 95
Windows 98
Windows Me
Windows 2000
Windows NT 4.0

• IPP
Windows 95
Windows 98
Windows Me
Windows 2000
Windows NT 4.0

• AppleTalk
Mac OS 8.6 ∼9.1

SNMP MIB-II, PrinterMIB, HostResourceMIB, RicohPrivateMIB
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